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NOTICE

No copying or reproduction of this document, in part or in whole, is permitted without the consent of LAPIS
Semiconductor Co., Ltd.

The content specified herein is subject to change for improvement without notice.

Examples of application circuits, circuit constants and any other information contained herein illustrate the standard
usage and operations of the Products. The peripheral conditions must be taken into account when designing circuits for
mass production.

Great care was taken in ensuring the accuracy of the information specified in this document. However, should you incur
any damage arising from any inaccuracy or misprint of such information, LAPIS Semiconductor shall bear no
responsibility for such damage.

The technical information specified herein is intended only to show the typical functions of and examples of application
circuits for the Products. LAPIS Semiconductor does not grant you, explicitly or implicitly, any license to use or exercise
intellectual property or other rights held by LAPIS Semiconductor and other parties. LAPIS Semiconductor shall bear no
responsibility whatsoever for any dispute arising from the use of such technical information.

The Products specified in this document are intended to be used with general-use electronic equipment or devices (such
as audio visual equipment, office-automation equipment, communication devices, electronic appliances and amusement
devices).

The Products specified in this document are not designed to be radiation tolerant.

While LAPIS Semiconductor always makes efforts to enhance the quality and reliability of its Products, a Product may
fail or malfunction for a variety of reasons.

Please be sure to implement in your equipment using the Products safety measures to guard against the possibility of
physical injury, fire or any other damage caused in the event of the failure of any Product, such as derating, redundancy,
fire control and fail-safe designs. LAPIS Semiconductor shall bear no responsibility whatsoever for your use of any
Product outside of the prescribed scope or not in accordance with the instruction manual.

The Products are not designed or manufactured to be used with any equipment, device or system which requires an
extremely high level of reliability the failure or malfunction of which may result in a direct threat to human life or create a
risk of human injury (such as a medical instrument, transportation equipment, aerospace machinery, nuclear-reactor
controller, fuel-controller or other safety device). LAPIS Semiconductor shall bear no responsibility in any way for use of
any of the Products for the above special purposes. If a Product is intended to be used for any such special purpose,
please contact a ROHM sales representative before purchasing.

If you intend to export or ship overseas any Product or technology specified herein that may be controlled under the
Foreign Exchange and the Foreign Trade Law, you will be required to obtain a license or permit under the Law.

Copyright 2008 - 2020 LAPIS Semiconductor Co., Ltd.

LAPIS Semiconductor Co. Ltd.
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1. Read This First

1.1  Precaution for Safe and Proper Use

This manual uses various labels and icons that serve as your guides to operating this product safely and properly so as to
prevent death, personal injury, and property damage. The following table lists these labels and their definitions.

. This label indicates precautions that, if ignored or otherwise not
Warning

completely followed, could lead to death or serious personal injury.

. This label indicates precautions that, if ignored or otherwise not
Caution

completely followed, could lead to personal injury or property damage.

Icons

A triangular icon draws your attention to the presence of a hazard. The illustration
inside the triangular frame indicates the nature of the hazard—in this example, an
electrical shock hazard.

A circular icon with a solid background illustrates an action to be performed. The
C illustration inside this circle indicates this action—in this example, unplugging the
power cord.

A circular icon with a crossbar indicates prohibition. The illustration inside this circle
indicates the prohibited action—in this example, disassembly.
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1.2 Important Safety Notes

Please read this page before using the product.

AWarning
Use only the specified voltage.

Using the wrong voltage risks fire or electrical shock.

At the first signs of smoke, an unusual smell, or other problems, unplug the board and

disconnect all external power cords.
Continued use risks fire and electrical shock.

Do not use the product in an environment exposing it to moisture or high humidity.
Such exposure risks fire or electrical shock.

Do not pile objects on top of the product.
Such pressure risks fire or electrical shock.

At the first signs of breakdown, immediately stop using the product, unplug the board,

and disconnect all external power cords.
Continued use risks fire and electrical shock.

V2V

&Caution

Do not use this product on an unstable or inclined base as it can fall or overturn,
producing injury.

Do not use this product in an environment exposing it to excessive vibration, strong
electromagnetic fields, or corrosive gases.
Such factors can loosen or even disconnect cable connectors, producing a breakdown.

Do not use this product in an environment exposing it to temperatures outside the
specified range, direct sunlight, or excessive dust.
Such factors risk fire and breakdown.

Use only the cables and other accessories provided.
Using non-compatible parts risks fire or breakdown.

Always observe the specified order for turning equipment on and off.
Using the incorrect order risks fire or breakdown.

Do not use the cables and other accessories provided with other systems.
Such improper usage risks fire.

9\ -1\%)%)|%]%,
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1.3 Notation

This manual utilizes the following notational conventions for convenience.

[Note]

[Reference]

[Execution example]

(note x)

[Note x]

A “note” indicates a section of the manual that requires special attention.

A “reference” provides information related to the current topic and indicates the page
number of a related section of the manual.

An “execution example” indicates an example related to the current topic.

“(note x)” is a reference to a numbered note that provides supplementary information
lower on the same page.

“Note x” provides supplementary information related to the passage marked with “(note
X)”.
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2. Overview

This chapter gives an overview of the Speech LSI Utility.

2.1  Objective

The Speech LSI Utility (hereafter called the Tool), is a utility tool for speech synthesis LSIs manufactured by LAPIS
Semiconductor. The user can edit ROM images to be written to the memory of those LSIs and control the sound device
control board via USB on PC.

In addition, the user can edit voice data that serves as the materials of ROM images.

The Tool supports the following speech synthesis LSls:

Category Series LSI
Speech LSI ML223xx ML22Q374
ML22Q394
ML224xx ML22420
ML22460
ML2253x ML22Q532
ML22Q533
ML22Q535
ML22530
ML2256x ML22562
ML22(Q)563
ML2257x ML22572
ML22(Q)573
ML22Q553
ML22594
ML226xx ML22Q623
ML22Q624
ML22Q625
ML22Q626
ML22620
ML22Q663
ML22Q664
ML22Q665
ML22Q666
ML22660
ML228xx ML22(P)823
ML22(P)824
ML22(P)825
ML22(P)863
ML22(P)864
ML22(P)865
ML22(P)802
ML.22(P)804
ML22(P)808
Others ML28860
ML28870
ML22(Q)321
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Speech MCU

ALL

ML610Q304
ML610Q359
ML610Q360
ML610Q380
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2.2  Operating Environment

To utilize the Tool, your PC must meet the following system requirements:
o Microsoft® Windows

> Windows 7*

»  Windows 8*

»  Windows 10*

*32-bit (x86) or 64-bit (x64)

e Processor and memory:

»  Apply to the requirements of OS.
e Hard disk area:

» Hard disk area with 1 Gbyte of free space
e Audio components:

» Windows-compatible sound car and a speaker
e USB port

2.3 Input-Output Files

23.1 Input Files

The Tool edits ROM images using a unit called project. A project includes voice data, which serves as materials, target
LSI, bank configuration, and option information, and their content is read from the following format files:

e Speech LSI Utility project files (*.spj)

As voice data that serves as materials, the following format files can be read:
o RIFF Wave files (*.wav)
<~ Sampling frequency: 4 to 96 [kHz]
< Bit resolution; 16 [bits], 8 [bits]
<> Number of channels: 1 (monaural)
<~ CODEC: Linear PCM
o AIFF Wave files (*.aif, *.aiff)
<> Sampling frequency: 4 to 96 [kHz]
< Bitresolution: 16 [bits], 8 [bits]
<> Number of channels: 1 (monaural)
<~ CODEC: Linear PCM
o PCM files (*.pcm)
< Sampling frequency: 4 to 96 [kHz]
< Bitresolution: 16 [bits] (linear PCM), 4 [bits] (ADPCM2)
<> Number of channels: 1 (monaural)
<~ CODEC: Linear PCM or ADPCM2

Any file with two channels (stereo) is read after being converted to monaural data separately by the conversion function
that the Tool has.

The speech synthesis data in the following format files, which is generated as materials inside the Tool, can be read:
e TOD files (*.tod)

The following format files serve as speech synthesis phrase data used to create speech synthesis data:
e CSV files about ROM file contents (*.csv)

o TEXT files about ROM file contents (*.txt)

e Option settings files (*.sop)

[Note] The maximum number of phrases in one edit phrase is 20,000. Also, an alert may appear due to lack of
the memory in your operating environment.
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2.3.2 Output Files

The edit results by the Tool are stored as project files in the following format files:
e Speech LSI Utility project files (*.spj)

In addition, the content of a project being edited can be output as a ROM image to the following format files:
e Motorola S files (*.s)
o Bin files (*.bin)

Also, as the information file of that ROM image, the following format file is generated and output at the same time:
o Text files (*.inf)
e CSV files (*.csv)

[Note] The phrase that ML22330/331/340/341/321 exceeds 64k byte in one voice data can not be replayed.
64 K bytes or more of data under voice is divided, and uses an edit phrase.

Voice data stored in a project file can be output to the following format files:
e PCM files (*.pcm)

< Sampling frequency: 4 to 48 [kHz]

< Bitresolution: 4 [bits]

<> Number of channels: 1 (monaural)

<~ CODEC: ADPCM2

The speech synthesis data to be generated inside the Tool is output to the following format files:
e TOD files (*.tod)

Speech synthesis phrase data, which is used to create speech synthesis data, can be saved as the following format files:
e CSV files (*.csv)
o TEXT files (*.txt)

Voice data edit results are stored in the following format files as well as PCM files and TOD files:

o RIFF Wave files (*.wav)
Sampling frequency: 4 to 96 [kHz]
< Bit resolution: 16 [bits], 8 [bits]
<> Number of channels: 1 (monaural)
<~ CODEC: Linear PCM

o AIFF Wave files (*.aif, *.aiff)
< Sampling frequency: 4 to 96 [kHz]
< Bit resolution: 16 [bits], 8 [bits]
<> Number of channels: 1 (monaural)
<~ CODEC: Linear PCM
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3.  Operational Description

This chapter describes the main method of operating the Tool. Refer to Chapter 4, “References,” for the description of
the functions not mentioned in this chapter, the detailed description of the operation method of the Tool in general, and
the name of each section of the user interface.

3.1 Installation

1.  When you insert installer CD in CD drive or DVD drive, the installer screen appears automatically. (In that case,
procedure No.2 and 3 are skipped.)

2. Open the installer CD by either of the following step.
@ Click “Start” button, and click “Computer” to open “Computer” window.
@ Double-click the icon of the CD/DVD drive in “Devices with Removable Storage”.

3. Double-click “setup” icon.

4. Go on with the installation by following the instructions on the screen. When “User Account Control (An
unidentified program wants to access your computer)” window is showed, click “Allow”.
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3.2  Speech LSI Utility

3.2.1 Startup

Open Tool by the following step.

B Click “Start” and point in order of “All Programs”, “LAPIS Semiconductor”, and “Speech LSI Tools” and then
click “SpeechLSIUtility3”.

When the Tool is launched, the following main window is displayed.

@9 Untitled - Speech LSI Utility

- O X
File Edit Tools Options View Help
D@ | 2
Device: | ML22530 v | BarkDiv.: |1 i

Blank Area: +16768896 | bytes [ ROM Capacity: 16777216 | bytes
Fosc: 4096 | MHz ROM Select: | Internal ROM Blank Area: 6530349 | msec (Fs /Format =

5400 f HQ-ADPCM(1/5) )
Bank 1

[] Add new item to bottom
r Phrase Address File Path Length [ms] Fs Format PreProcess HF Filter

B voume: [ Convert Insert EditROM...
olume: Fs: 000
Insert Blank Select All
ot - 175}
Speed: " Format: HQ-ADPCM(1/5)
12 1 2 Filter Select: Delete Arrange
pitch: % PreProcess Convert Create...
-20 0 20
Ready
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3.2.2 Editing a Project

The following sections describe the procedure for first preparing a project, then writing the results obtained by
registering voice data files that serve as materials and performing various edit operations out as a ROM image for LSI,
then finally saving the project.

3.2.3 Creating and Reading a Project

3.2.3.1 Creating a New Project

Use either of the following methods to create a new project:
W Select “New” in the “File” menu.
W Click the appropriate button on the toolbar.

3.2.3.2 Reading an Existing Project

Use either of the following methods to display the “Open” dialog box, then select the Speech LSI Utility project file
(*.spj)-

W Select “Open...” in the “File” menu.

m Click the appropriate button on the toolbar.

10
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3.2.4 Selecting the Target LSI

From the “Device” pull-down list in the main window, select the model number of the target LSI.

B8 Untitled - Speech LS Utility

File Edit Tools Options View Help
DS M| | | ?

>

Fosc: AL
Bank 1 Speech LSI >
r Speech MCU b

Device: ML22Q374 Bank Div.:

ALL

ML22 3xx
ML224xx
ML2253x
ML2256x
ML2257x
ML226xx
ML228xx

1

Others

ALL

B L Volume:

Speed:

Pitch:

Ready

1/2 1

-20 0

20

v ML22Q374
ML22Q394

ML22420
ML22460

ML22Q532
ML22Q533
ML22Q535
ML22530

ML22562
ML22(Q)563

ML22572
ML22(Q)573
ML22Q553
ML22594

ML22Q623
ML22Q624
ML22Q625
ML22Q626
ML22620

+88576| bytes / ROM Capacity: bytes
6920| msec (Fs / Format = | 6400 / 16bit Straight PCM | )

[ ] Add new item to bottom

th[ms] Fs Format PreProcess HF Filter
Insert Edit ROM...
ls000
Insert Blank Select All
labit ADPCM2
Delete Arrange
Convert Create...

11
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3.25 Configuring Bank Settings

A ROM image is divided into one or more than one bank (the number of banks that can be divided depends on the

specification of the selected target LSI). In addition, each bank consists of the following two areas:

» Address area: Voice data that has been recorded as materials is recorded in this area sequentially.

» Phrase area: Area where an edit phrase, which is either an arbitrary single material voice data item or arbitrary
multiple material voice data items combined freely, is created and recorded. These material voice data items are
recorded in addresses as the control units used in LSI’s performing voice playback processing. A silence interval of
any length of time can be added in an edited phrase in addition to material voice data.

The maximum capacity of a ROM image varies depending on the model number of the target LSI. The remaining size
for the contents currently being edited regarding the selected LSI and Bank is displayed in the Blank Area [byte]
column in the main window.

To divide a ROM image into multiple banks, select the number of divisions from the "Bank Div.” pull-down list.

Untitled - Speech LS| Utility
File Edit Tools Options View Help
D& | | | 2
Device: ML22(P)808 Bank Div.:
Fosc: MHz ROM Seled
Bank 1
‘ r Phrase Address File Path

Banks to be edited can be switched by clicking on each tab that appears according to the specified number of bank
divisions at the top of the phrase list.

Untitled - Speech LSI Utility

Eile Edit Jools Options View Help
O - | [o o | 7

Device: ML22(P)808 Bank Div.: 4 iy

DM Select: Internal ROM

Bank 1 Bank 2 Bank 3 Bank 4
r Address

Phrase Path

12
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3.2.6 Voice Data

3.2.6.1 Recording Voice Data in a Project

To record a voice data file that serves as material in the project currently being edited, use the Windows Explorer to drag
& drop the icon of the voice data file in the file format shown in Section 2.3.1 into the main window.

File Edit Tools Options View Help
== | | ?
Device: ML22530 Bank Div.: |1 ¥ Blank Area: +16768896| bytes [ ROM Capacify
Fosc: 4.096| MHz ROM Select: Internal ROM Blank Area: 6550349 | msec (Fs / Format =
Bank 1
r Phrase Address File Path Length[ms] Fs Format
l ®e . = B4 Mono
[}
° _ -
e, foh AE RF O 22-997 V-
® > T » Sound » Wav » Riff » Mono
°o [ 2z
D19 70 o
@ 0.wav
3 (DI \olume: & Creative C| [0 1.wav
@ OneDrive 18 2.wav
Speed: 18] 3.wav
W
1/2 1 ¥PC @ 4.wav
Pitch: . Transcend 18] 5.wav
. . @ 6.wav
B Untitled - Speech LS Utility — O X
File Edit Tools Options View Help
D& M| o c|?
Device: ML22530 Bank Div.: 1 i Blank Area: bytes / ROM Capadity: bytes
Fosc: MHz ROM Select: Internal ROM Blank Area: msec (Fs / Format = 6400 / HQ-ADPCM(1/5) )
Bank 1 ["]Add new item to bottom
(m| Phrase Address File Path Length[ms] Fs Format PreProcess HF Filter
[~ - 0 0.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 HQ-ADPCM(1/5) -
Convert Insert Edit ROM...
P volume: v Fs: 8000
) Insert Blank Select All
Speed: X Format: HQ-ADPCM(1/5)
1/2 1 2 Filter Select: Delete Arrange
Pitch: % s Convert Create...
20 0 20
Ready

13
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When “Add new item to buttom” checkbox is off, voice data recorded by Drag & Drop is added to the (end, or position
of the low which has been selected of the) phrase list in the main window.

6400 / HQ-ADPCM(1/5) )

Add new item to bottom

When “Add new item to buttom” checkbox is on, voice data recorded by Drag & Drop is added to the end phrase list in
the main window (regardless of the selected state of the list).

B Untitled - Speech LS Utility — O P
File Edit Tools Options View Help
L= |0 | %
Device: ML22530 Bank Div.: 1 > Blank Area: +16755876| hytes /| ROM Capacity: 16777216| pytes
Fosc: 4.096| MHz ROM Select: [nternal ROM Blank Area: 6545264 msec (Fs / Format = 6400 / HQ-ADPCM(1/5) )
Bank 1 Add new item to bottom
r Phrase Address File Path Length[ms] Fs Format PreProcess HF Filter ~
[ 1 2.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 HQ-ADPCM(1/5)
[ - 2 3.wav C:¥Soundy¥Wav¥Riff¥Monosy 500 8000 HQ-ADPCM(1/5)
[~ - 3 4.wav C:¥Sound¥Wav¥RiffyMonosy 500 8000 HQ-ADPCM(1/5)
[ - 4 5.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 HQ-ADPCM(1/5)
[ - 5 6.wav C:¥Soundy¥Wav¥Riff¥Monosy 500 8000 HQ-ADPCM(1/5)
[ - 6 7.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 HQ-ADPCM(1/5)
[ - 7 8.wav C:¥Soundy¥Wav¥Riff¥Monosy 500 8000 HQ-ADPCM(1/3)
[~ - 8 1.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 HQ-ADPCM(1/5) - -
e 9 0.wav C:¥Sound¥Wav¥Riff¥Monos 500 8000 HQ-ADPCM(1/5) = = w
Convert it ROM
B [ _ Insert Edit M... \
Volume: ' [JFs: 8000
Insert Blank Select All /
Speed: N [ ]Format: HQ-ADPCM(1/5)
1/2 1 2 Filter Select: Delete Arrange
Pitch: % EreEreies Convert Create...
-20 0 20
Ready

Voice data recorded in a project is added to the end, or position of the low which has been selected of the phrase list.
However, it can be rearranged to any position in the list by choosing the target line in the list and then clicking the

| N |or| / |button.

3.2.6.2 Setting Sound Quality

Use the following procedure to set the sampling frequency, format, and preprocessing for the speech speed function

(currently no device suppots this feature) that are used when voice data recorded in a project is output as part of a ROM

image:

@ Inside the phrase list, select the line corresponding to the voice data whose settings you want to change (to select
multiple lines, click the target line while pressing the Shift key).

@ To change the sampling frequency of the selected voice data, select the ”Fs” checkbox and select the desired value
from the pull-down list on the right of the checkbox.

@ Likewise, to change the format, select the "Format” checkbox and select the desired format from the pull-down list
on the right of the checkbox.

@ Likewise, to change the HF filter type, select the "Filter Type” checkbox and select the desired format from the
pull-down list on the right of the checkbox.

® To perform the preprocessing for the speech speed function, select the "PreProcess” checkbox.

® Click the “Convert” button to reflect the selected settings.

14
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Conwert

7|Fs: | 16000 -
¥|Format: |HQ-¢5=DP'CM'[U5] "|
7|Filter Select: | (Bypass) v

PreProcess Convert

Even if any change is made to the above settings, it is done nondestructively upon generation of a ROM image.
Therefore, no recorded material voice data file will be changed. The Tool allows the user to check the sound quality to
be produced when the recorded voice data is actually output as a ROM image, not the sound quality of material voice
data, by previewing it.

3.2.6.3 Previewing

Voice data recorded in a project can be previewed by first selecting the corresponding line in the phrase list and then
using either of the following methods:

m Click the playback (u) button.

M Press the Space key of the keyboard.

Likewise, to stop previewing, use either of the following methods:

vesonl ]
B Click the stop( ) button.

MW Press the Space key of the keyboard.

To adjust playback volume, use the “Volume” slider. To change the speech speed or pitch in the speech speed function
(currently no device suppots this feature) in previewing, use the “Speed” or “Pitch” slider.

3.26.4 Rearranging Voice Data in a ROM Image

The value indicated in the ”Address” column in the phrase list indicates the management number of voice data in the
Address area. The address value that was in effect when specific voice data was recorded is always set regardless of the
order of listing in the list. However, it is possible to rearrange voice data and reassign management numbers using the
following methods:

W Click on the list header ”Address” of the Address column to display a pop-up menu.
W To rearrange voice data, select ”Sort Number” from the pop-up menu.

Bank 1

- Phrase Address File

- 7 Sort Mumber Fa\
[ - ] test.wav Gi¥wan
[ - 1 test? wav G ¥wan

To record voice data that has been added to a project in the Phrase area (turn voice data into a phrase singly and then
record it in an LS| ROM image to make it playable), select (check) the checkbox of the appropriate row in the list. The
checked item will be assigned a number in the Phrase column. This value is used for managing the items that are output
to the Phrase area in the order the items are displayed in the list.

15
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Bank 1

v | Phrase | Address | File | Path Length [ms] Fs
- 0 test.wav G ¥wavi 66 16000
1 test2 wav Gr¥wavy 347 16000

testI.wav G ¥wavi

3.2.6.5 Relating Speech Sound

When you select "Speech Sound ..." from the pop-up menu that appears when you right-click (s) on selected sound
phrase on the list, Speech Sound dialog box will appear.(can select multiply) If a Speech Sound is related with a selected
sound phrase, or if the same text has been associated when the sound phrase were multiply selected, the combo box of
Speech Sound dialog will display the related text in the initial state.

After editing the combo box of Speech Sound dialog, and press the OK button, the sound phrase has been selected text
of the Speech Sound has been selected in the combo box.

16
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3.2.7 Edit Phrase
3.2.7.1 Creation

Use either of the following methods to create a new edit phrase:

W Select "Insert” in the “Edit” menu.
W Click the “Insert” button.

B Untitled - Speech LSI Utility
File Edit Tools Options View Help

Dc Undo Ctrl+Z
Dex Redo Crl+Y  Jepiv.: |1 b Blank Area: +16767343| bytes / ROM Capacity: 16777216| pytes
Phrase Copy Ctrl+C
Fos M Select: [Internal ROM Blank Area: 6349743 | msec (Fs / Format = 6400 / HQ-ADPCM(1/5) )
Paste Ctrl+Vv
Ba S Del Add new item to bottom
r File Path Length[ms] Fs Format PreProcess HF Filter
[ Replace Ctrl+R C:¥Sound¥Wav¥RIff¥Monos 500 8000  HQ-ADPCM(1/5) -
Copy
Select All Ctrl+A
Insert Blank Ctrl+B
Edit ROM
Convert i
P [ ) Edit ROM...
polimes v Fs: 8000
) 0 ¥ Select All
Speed: . Format: HQ-ADPCM(1/5)
1/2 1 2 Filter Select:  |(Bypass) Delete Arrange
Pitch: % Biralrogss Convert Create...
-20 0 20

17




LAPIS Semiconductor Co., Ltd.

3.2.7.2 Edit

An edit phrase contains nothing in its newly created state. To edit the contents of it, choose the row of the appropriate
edit phrase, then use one of the following methods to open the edit phrase setting window (will be automatically
displayed in the case of new creation).

B Select "Edit ROM...” in the “Edit” menu.

W Double-click on the corresponding row in the list.

H Click the “Edit ROM...” button.

3.2.7.3 Setting a Name
Enter the name of the newly created edit phrase into the "Name” column to set it in the Tool.

Phrase X
)
oo D

No | Address File

Select All Delete

File: 00 A.wav w Add
Mute Time: I:l msec | Replace Add
Volume: Set

18



LAPIS Semiconductor Co., Ltd.

3.2.7.4 Recording Voice Data
The “File” pull-down list shows a list of voice data files already recorded in the Bank being edited.

Phrase X

)

Name: |EROMO

No | Address File

Select All Delete

File:

Mute Tinge

Volume:

Choosing one item from the “File” pull-down list and clicking the ”Add” button adds the voice data to the edit phrase.

Phrase X
Wy
Name: EROMO

No | Address File

Select All

File: 00 A.wav v
Mute Time: |:| msec  Replace
Volume: Set

Close

19
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3.2.75 Recording a Silence Interval
To insert a silence interval, first enter its length of time into the "Mute Time” entry field in milliseconds,

Phrase X
"]
Mo ‘EROM2
No | Address File
1 00 | Awav
\ / Select All Delete
File: 00 A.wav M Add
Mute Tige ‘ msec | Replace Add
Volume: Set

then click the “Add” button. The silence interval wll then be added to the edit phrase.

¥y

{ Name: ‘EROMU

No | Address File
1 00 | Awav

\ / Select Al Delete |
File: 00 A.wav M Add |
| Mute Time: msec | Replace
| Volume: Set
Close

20
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3.2.7.6 Rearrangement Setting in a ROM Image

Silence intervals and voice data items that have been added to the edit phrase setting window are played in the order they
are currently listed as one phrase. To change the order of the items to be played, first select the target item in the list and

thenclickthe[ N ]or[ / ]button.

Phrase X
)
Name: ‘ERDMO ‘
No | Address File
1 00 A.wav
2 = Mute 20 msec
3 01 B.wav
4 02 C.wav
Select All Delete
File: 04 E.wav b Add
Mute Time: I:l msec | Replace Add
Volume: Set
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3.2.7.7 Changing Playback Volume of Voice Data

If ML22(Q)355/ML22Q374/ML22Q394 is selected as a target LSI, playback volume of each voice data can be specified.
To change the playback volume of the voice data, first select the target item in the list and then enter the volume value
into the "Volume” entry field in hexadecimal number (00 ~ 1F),

Phrase X
vy
N ‘EROMO
No | Address File Volume

1 00 " | Awav 9

2 - Mute 20 msec -

3 01 B.wav 9

4 02 C.wav 9

A 4 Select All Delete

File: 03 D.wav v Add

Mute Time: msec | Replace Add

Set
Next click the “Set” button.
Phrase X
)
Name: |EROMO
No | Address File Volume

1 00 | Awav 9

2 - Mute 20 msec -

3 01 B.wav 9

4 02 C.wav 9

A '4 Select All Delete

File: 03 D.wav v Add
Mute Time: l:l e Add
Volume:

22
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On the main window, in the same way as voice data, any edit phrase selected from the phrase list in the main window
can be previewed.

B8 Untitled - Speech LS Utility — O P
File Edit Tools Options View Help
SR IEEIC RS
Device: ML22530 Bank Div.: 1 e Blank Area: +16758896| pytes / ROM Capacity: 16777216| pytes
Fosc: 4.096| MHz ROM Select: Internal ROM Blank Area: 6546443 | msec (Fs / Format = 6400 / HQ-ADPCM(1/5) | )
Bank 1 Add new item to bottom
I | Phrase | Address | File \ Path | Length[ms] | Fs \ Format | PreProcess |  HF Filter ‘
|_ - 0 A.wav C:¥Sound¥WavxRiff¥Monosy 500 8000 4bit ADPCM2 - -
|_ 1 B.wav C:¥Soundy¥Wav¥Riff¥Monosy 500 8000 4bit ADPCM2 - -
|_ 2 C.wav C:¥Sound¥Wav¥Riff¥Monos 500 8000 4bit ADPCM2 - -
|_ 3 C:¥Sound¥Wav¥Riff¥Monos 500 4bit ADPCM2
4 E.wav C:¥Sound¥WavkRiff¥Monoy 500 8000 4bit ADPCM2 - -
[~ - EROMO - - - - - -
Convert H
[ S ' Insert Edit ROM... A
: Fs: 8000 v
Insert Blank Select All WV
Speed: N Format: 4bit ADPCM2 v
1/2 1 2 Filter Select:  |(Bypass) ~ Delete Arrange
Pitch: % rafreaEss Convert Create...
-20 0 20
Ready
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To record an edit phrase in the Phrase area (enable playback of an edit phrase recorded in the LSI), check the checkbox
for the target row in the list. The checked item will be automatically assigned a management number in the Phrase area,

and the number is displayed in the Phrase column.

B Untitled - Speech LS Utility
File Edit Tools Options View Help

DS H|BEo |7

Device: ML22530 Bank Div.: 1 > Blank Area: +16758854| pytes / ROM Capacity: 16777216| pytes
Fosc: 4.096| MHz ROM Select: [nternal ROM Blank Area: 6546427 | msec (Fs / Format = 6400 / HQ-ADPCM(1/5) )
Bank 1 Add new item to bottom
# | Phrase | Address | File \ Path | Length[ms] | Fs \ Format | PreProcess |  HFFilter ‘
|_ - 0 A.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 4bit ADPCM2 - -
|"_ 0 1 B.wav C:¥Soundy¥Wav¥Riff¥Monosy 500 8000 4bit ADPCM2 -
|"_ 1 2 C.wav C:¥Sound¥Wav¥RiffyMonosy 500 8000 4bit ADPCM2 -
- 3 D.wav C:¥Sound¥Wav¥Riff¥Monoy 500 8000 4bit ADPCM2 -
4 C:¥Sound¥WaveRiff¥Monosy 500 4bit ADPCM2

Convert "
P m ) Insert Edit ROM... A
Volume: ' Fs: 8000
Insert Blank Select All v
. Format: 4bit ADPCM2
Speed: X
1/2 1 2 Filter Select:  |(Bypass) Delete Arrange
Pitch: % PreProcess Convert Create...
-20 0 20
Ready
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3.2.8 Option Setting
3.2.8.1 ML22(Q)321

If ML22(Q)321 is selected as a target LSI, data in the initialization area and data in the event management area are
edited on the Mask Option dialog box and Event Setting dialog box, respectively.

Use the following method to open the Mask Option Setting dialog box:
B Select “Options” menu — "ML22(Q)321...” — "Mask Option Setting...”.

Use the following method to open the Event Setting dialog box:
B Select “Options” menu — "ML22(Q)321...” — "Event Setting...”.

3.282  ML22(Q)56x

If ML22(Q)56x is selected as a target LSI, the sampling frequency which applies HF Filter is set up on the HF Filter
Active Frequency dialog box.

Use the following method to open the HF Filter Active Frequency dialog box:
B Select “Options” menu — "ML22(Q)56x...".

3.2.8.3 ML22(Q)57x/553

If ML22(Q)57x/ML22Q553 is selected as a target LSI, the sampling frequency which applies HF Filter is set up on the
HF Filter Active Frequency dialog box.

Use the following method to open the HF Filter Active Frequency dialog box:
B Select “Options” menu — "ML22(Q)57x/553...".

3.2.84 ML22Q374

If ML22Q374 is selected as a target LSI, data in the initialization area and data in the event management area are edited
on the Mask Option dialog box and Event Setting dialog box, respectively.

Use the following method to open the Mask Option Setting dialog box:
B Select “Options” menu — "ML22Q374...” — "Mask Option Setting...”.

Use the following method to open the Event Setting dialog box:
B Select “Options” menu — ” ML22Q374...” — "Event Setting...”.

3.2.85 ML22Q394

If ML22Q394 is selected as a target LSI, data in the initialization area and data in the event management area are edited
on the Mask Option dialog box and Event Setting dialog box, respectively.

Use the following method to open the Mask Option Setting dialog box:
B Select “Options” menu — "ML22Q394...” — "Mask Option Setting...”.

Use the following method to open the Event Setting dialog box:
B Select “Options” menu — ” ML22Q394...” — "Event Setting...”.
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3.2.8.6 ML22594

If you select ML22594 as the target LSI, you can edit HF Filter Active Frequency dialog settings for each type of filter
to apply the sampling frequency and the corresponding HF Filter.

Use the following method to open the HF Filter Active Frequency dialog box:
B Select “Options” menu — "ML22594...".

3.2.8.7 ML610Q304

If ML610Q304 is selected as a target LSI, data in the event management area are edited on the Event Setting dialog box.

Use the following method to open the Event Setting dialog box:
MW Select “Options” menu — "ML6100Q304...".

3.2.8.8 ML610Q359

If ML610Q359 is selected as a target LS|, data in the event management area are edited on the Event Setting dialog box.

Use the following method to open the Event Setting dialog box:
W Select “Options” menu — "ML6100Q359...".

3.2.8.9 ML610Q360

If ML610Q360 is selected as a target LS|, data in the event management area are edited on the Event Setting dialog box.

Use the following method to open the Event Setting dialog box:
B Select “Options” menu — "ML6100Q360...".

3.2.8.10 ML610Q380

If ML610Q380 is selected as a target LS|, data in the event management area are edited on the Event Setting dialog box.

Use the following method to open the Event Setting dialog box:
B Select “Options” menu — "ML6100Q380...".

3.2.8.11 ML22(Q)53x/62x/66x

If ML22(Q)53x/62x/66x is selected as a target LSI, data in the event management area are edited on the User setting
parameter dialog box.

Use the following method to open the User setting parameter dialog box:
B Select “Options” menu — "ML22(Q)53x/62x/66X...".

3.2.8.12 ML28(Q)86x/87x

If ML28(Q)86x/87x is selected as a target LSI, data in the event management area are edited on the User setting
parameter dialog box.

Use the following method to open the User setting parameter dialog box:
W Select “Options” menu — "ML 28(Q)86x/87x...".
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3.2.9

Selecting source oscillation frequency (Fosc)

When using an external clock, set the frequency of the external clock. With this setting, the sampling frequency is set
according to the frequency. In addition, by using this function, when using an external clock, it is possible to compensate
so that the speed and pitch of the audio data generated by the internal clock do not change.

Internal clock frequency of the LSI is set when the project is created.

B Untitled - Speech LS| Utility - O X
File Edit Tools Options View Help
D& HE| o o |9
Device: | ML22530 e Bank Div.: i ~ Blank Area: +16648223 | hytes / ROM Capacity: 16777216 | bytes
| Fosc: 4.096 | MHz || ROM Select: |Internal ROM Blank Area: 6503212 | msec (Fs / Format = 6400 [ HG-ADPCM{1/5) )
Bank 1 Add new item to bottom
I~ Phrase Address File Path Length[ms] Fs Farmat PreProcess HF Filter
I - 1] 004_08_01.aif C:¥Users¥crimson¥Docum  $000 6400 HQ-ADPCM(1/5) -
] 1 008_08_01.aif C:¥Users¥crimson¥Docum  $000 2000 HQ-ADPCM(1/5) -
TN 2 011_08_01.aif C:¥Users¥cimson¥Docum 8000 11025 HQ-ADPCM(1/5) -
[ - 3 012_16_01.aif C:¥Users¥aimson¥Docum 8000 12000 HQ-ADPCM(1/5) -
i = - EROMO E E E E - E
Convert "
[ ] Insert Edit ROM... Y
r"“ Valume: ' = 11025
Insert Blank Select Al /
Speed: . Format: HQ-ADPCM(1/5)
12 1 2 Filter Select: Delete Arrange
Pitch: % PreProcess Convert Create...
=20 a 20
Ready NUM
When Fosc is changed, the sampling frequency Fs at the time of ROM image output is changed.
§8l Untitled - Speech LSI Utility - O *
File Edit Tools Options View Help
Ded = R|o o|?
Device: |ML22530 ~| BankDiv.: |1 ~ Blank Area: bytes / ROM Capacdity: bytes
Fosc 4.000 | MHz JJROM Select: |Internal ROM Blank Area: msec (Fs / Format = 6400 / HQ-ADPCM(1/5) )
Bank 1 Add new item to bottom
I Phrase Address File Path Length[ms; Fs Format PreProcess HF Filter
[ - 1] 004_08_01.aif C:¥Users¥crimson¥Docum 8000 6250 HQ-ADPCM(1/5)
M o 1 008_08_01.aif Ci¥lsers¥crimson¥Docum 8000 7812 HQ-ADPCM{1/5)
TR 2 011_08_01.aif C:¥Users¥crimson¥Docum 8000 10767 HQ-ADPCM(1/5)
- 3 012_16_01.aif C:¥Users¥crimson¥Docum 8000 11719 HQ-ADPCM(1/5)
(-3 - EROMO = = = - = =
Convert :
[”'»». [ ] Insert Edit ROM... y
Volume: ' Fs: T
Insert Blank Select Al £
Speed: . Format: HQ-ADPCM{1/5)
12 1 2 Filter Select: Delete Arrange
Pitch: % PreProcess Convert Create...
-20 a 20
Ready NUM
[Note] Resampling process is executed when the LSI ROM image is created.
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3.2.10 Generating an LSI ROM Image

To make the results of editing created as an LSI ROM image, use either of the following methods to open the Create
ROM dialog box:

B Select "Create ROM...” in the “File” menu.

B Click the “Create” button in the main window.

Create ROM X

TEST ROM Data
(®) Release ROM Data

() Motorola S File
(®) Binary File

Event area start address

Data area start address 8 (HEX)

1

Edit ROM area start address  [2728 (HEX)

File:
C:¥Users¥Documents¥Untitled.bin ‘

*Create ROM Dialog image when ML610Q360 selected
Displaying controls and enabled controls are different by selecting targetLSl

A ROM image can be output in the two formats shown in the dialog box. Use the radio buttons of the dialog box to
choose either format.

o Motorola S files (*.s)
o Bin files (*.bin)

Click the ...” button to specify the output file name and then click "OK” to complete operation.

In devices that use external data ROM, it is possible to separately specify an address where voice data is to be allocated
and an address where an edit phrases is to be allocated. Set the starting address of voice data in the “Data area start
address” field and that of an edit phrase in “Edit ROM area start address” each in hexadecimal. The address values
already set in the fields at the opening of the Create ROM dialog box are the initially set values with no offset set in each
area.

When ML610Q304/ ML610Q359/ ML610Q360/ ML610Q380 is chosen as the target LSI, “Event area start address”
“Data area start address” “Edit ROM area start address” are enabled and you can specify start addresses of each
areas

In addition “Apply” button is displayed. By clicking Apply button, automalically calculate and replace start addresses of
“Data area start address” and “Edit ROM area start address” from the address of “Data area start address” on generated
ROM binary image

When ML22310/330/340/331/341/321/Q374/Q394 is chosen as the target LSI, depending on the setting of option, it isn't
sometimes replayed normally in SDCB. In this case, choose "TEST ROM Data". "TEST ROM Data" changes the
parameter which was set with "Event Setting dialog" for SDCB and creates a ROM image.




LAPIS Semiconductor Co., Ltd.

3.2.11 Saving a Project

Use either of the following methods to save the current edit content as a project file:
B Select “Save” or “Save As...” in the “File” menu.
M Click the appropriate button on the toolbar.

Voice data that has been recorded in a project exists on a disk as a file independent of the project file. A project file
stores only the location where the voice data file is saved and does not store the entity of the voice data internally.
Therefore, if any change is made to a voice data file by a general Widows operation, the project or the content of the
ROM image to be created will change.

When backing up work contents, it is required to save all the voice data files as well as project files.

If the file path of an audio file that was used by sound phrase on the project file is no longer able to refered cause
changing the directory or the name of the folder, Display “WAV File Path“ dialog from ”Tools...”->"Settings...” on
menu, and add the path of the folder has been changed name to list. After opening the project file, the reference path of
the audio data file(s) will be replaced with the path to the folder that was changed.
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3.2.12

Importing ROM Data

To create a project file from ROM Data, proceed as follows:

B Select "Import ROM Data...” in the “File” menu.

B8 Untitled - Speech LS| Utility — m] *
File Edit Tools Options View Help
MNew
Open... Cirl+0
a ~ Blank Area: +1676885% | bytes [ ROM Capacity: 16777215 | bytes
ose
nal ROM Blank Area: msec (Fs [ Format = 6400 f HQ-ADPCM(1/5) i)
Save Ctrl+5
Save As. [] Add new item to bottom
Path Length[ms] Fs Format PreProcess HF Filter
Import ROM Data... 3
Import TOD Data...
Export Material...
Import Speech Sound Data...
Create ROM...
1sample_project.spj
2 C:¥Users¥.. ¥Untitled3.spj Convert T Edit ROM....
3 C¥Users¥,. ¥Untitled2.spj Fs: 3000
4 E¥Untitled2.spj Insert Blank Select Al
Format: HQ-ADPCM(1/5)
Exit
Filter Select: Delete Arrange
Pitch: % PreProcess Convert Create...
-20 0 20
Import an existing ROM data
® Dialog will show up
File Edit Tools Options View Help
T EIEREEIE
Device: |ML28360 ~| BankDiv.: |1 ~ Blank Area: +16768856 | bytes [ ROM Capacity: 16777216 | bytes
Fosc: 4.096 | MHz ROM Select: |Internal ROM Blank Area: 6550349 | msec (Fs / Format = 6400  HQ-ADPCM(1/5) ]
Bank 1 [ add new item to bottom
[l Phrase Address File | Import ROM Data % Tt PreProcess HF Filter
Device: | ML28880 ~ | BankDiv.: |1
File: | |
Wav Dir:| |
Cancel
l_ Insert Edit ROM...
[\ Valume: ' == 2000
Insert Blank Select Al
Speed: " Format: HQ-ADPCM(1/5)
12 1 2 Filter Select: Delete Arrange
Pitch: % PreProcess Convert Create...
-20 0 20

Ready
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W Select ROM data file path in the “File:” field

[ B x
T » PC » Fm= v O mple_ror 1] 2
ZE - FLUTALS- =~ m @
A 2 ~ F42
i
B | | sample_rom.bin 16,384 KB
| | nl L |
[
d
. w
FrA L& (N): |samp\e,rom.bir| v| All Known Files (*.hex;*.5;".bin) ~
F<0) Fooull

“Device:”, “Bank Div:” and “Fosc:” will be filled in automatically if there is the .inf file named same as the ROM
file you want to import in the same directory with the ROM.
Otherwise, please fill those fields manually.

M |n the same way, select the directory to save the audio files expanded from the ROM in the “Wav Dir:” field
B Click “OK”

L2
File Edit Tools Options View Help
DEHE| EXIE
Device: |ML28860 ~ Bank Div.: 1 ~ Blank Area; +16758856 | bytes [ ROM Capacity: 167772165 | bytes
Fosc: 4.096 | MHz ROM Select: | Internal ROM Blank Area: 6550345 | msec (Fs / Format = 6400 [ HQ-ADPCM(1/5) )
Bank 1 [] Add new item to bottom
I Phrase Address File | import ROM Data % Eat PreProcess HF Filter
Device: |mML28860 Bank Div.: | Fosc:| 4,005
File: |C:¥Use|—s- T BT - =T T EI
WEVDif:|C:¥Users' | [ SRS B D | |,
oK Cancel
l\ r Insert Edit ROM...
Volume:
olume L Fs: e
Insert Blank Select All
Speed: " Format: HQ-ADPCM(1/5)
1f2 1 2 Filter Select: Delete Arrange
Fitch: % PreProcess Convert Create...
-20 0 20
Ready
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M Dialog will show “Read Completed!” when you succeed

-]
File Edit Tools Options View Help

D& H| | | ®

Device: |ML283&0 ~ | BankDiv.: |1 ~ Blank Area: +16760299 | bytes [ ROM Capacity: 16777216 | bytes
Fosc: 4.096 | MHz ROM Select: |Internal ROM Blank Area: 6546991 | msec (Fs / Format = 6400 [ HQ-ADPCM(1/5) )

Bank 1 [ Add new item to bottom
| Phrase Address File Path | Lengthfms] | Fs Format PreProcess HF Filter
[ - 0 sample_rom_000_0.w: C:¥Usersy Speech LSI UHility > 0o HQ-ADPCM{1/5) - -
- - 2 sample_rom_002_0.w: C:¥Usersy oo HQ-ADPCM{1/5) - -
- 1 sample_rom_001_0.w: C:¥Usersy 0o HQ-ADPCM{1/5) - -
r - 3 sample_rom_003_0.wi C:¥Usersy o Read Completedt PO HO-ADPCM(1/S) - -
- - 4 sample_rom_004_0.w: C:¥Usersy oo HQ-ADPCM{1/5) - -
- 5 sample_rom_005_0.w: C:¥Usersy 0o HQ-ADPCM{1/5) - -
M o - sample_rom_ED_000 - - - -
P voume: ] e Insert EditROM...
’ Fs: 3000
Insert Blank Select Al
Speed: . Format: HQ-ADPCM(1/5)
12 1 2 Filter Select: Delete Arrange
Pitch: % PreProcess Conwvert Create...
-20 0 20

Ready

[Note] If there is no .inf file, the leading blank phrase(s) will be skipped.
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3.3  WaveEditor

3.3.1 Activating the WaveEditor Window

If it is desired to edit the material itself of a voice data file recorded in a project, it can be done on the WaveEditor
window. The contents of a voice file itself are changed in this work (the contents of a voice file itself are not changed in
the work done in a main window).Therefore, in the project currently being edited or some other project, all the sections
that are using the same voice data file are to be affected by the edit results.

To edit a voice data file, select the corresponding row in the list in the main window and then use either of the following
methods to activate the WaveEditor window:

File Path Length[ms] Fs
004_08_01.wav C:¥Sound¥Wav¥Riff¥Mon 8000 G400
008 _08_0l.wav £ S Ee i
011_08_01.wav Fhrase Copy Ctrl+C 11025
012_08_0l.wav Paste Chrl+V 12000
ERCMO -

Delete Del
Replace Ctrl+R
Copy 3
[] WawveEditor...
Export Material...
PCM2
Speech Sound... —

B Select "WaveEditor...” in the “Tools” menu.
W Select "WaveEditor...” accessible from the context menu that appears when the target row in the list is right-clicked.
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A waveform window for the selected voice data file is displayed in the WaveEditor window that appears.

§2. WaveEditor - 004_08_01.wav [ R

File Edit View Play Insert Effect Window Help

= | | & Bl®e @& %

B 004_08_01.wav =N EcR =

[¥0:00:00°000 00:00:02°000 (40:00:04°000 (40:00:06°000 I{m:{:n:na'{m %
|

{| ﬁh |

'fulﬂ”hll I"'w h |l| ,. "“”“\ ‘
LRinil ‘ |
AR '\

Display Unit | Time = Sample rate{Hz): 4000

Ready

By clicking the @ button and the @ button, the display of the amplification direction can be expanded and reduced,
respectively. In the same way, by clicking the @] putton and the lﬁ'] button, the display of the time direction can be

expanded and reduced, respectively. To display the entire waveform, click the @ putton (the entire waveform may not
be displayed depending on the length of the waveform and the size of the window).
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3.3.2 Playing Back Voice Data

To play back voice data, use one of the following methods on the WaveEditor window:

W Select “Play / Stop” in the “Play” menu.
B Click the appropriate button on the toolbar.

=]
Hoc»BEREOEAS| T

M Press the Space key on the keyboard. — Play

To stop playback, use one of the following methods:

M Select "Play / Stop” in the “Play” menu.
B Click the appropriate button on the toolbar.

- I
| | B ®® '

E Stop

M Press the Space key on the keyboard.

The playback cursor can be moved by clicking on any position on the waveform window.

Also, the playback cursor can be moved to the top of the waveform by using one of the following methods:
B Select "Go to Start” in the “Play” menu.

B Click the appropriate button on the toolbar.

=]
CIEEIFEYIEICERCE

L— Go to Start

M Press the Ctrl+Home keys on the keyboard.

Likewise, the playback cursor can be moved to the end of the waveform by using one of he following methods:
B Select "Go to End” in the “Play” menu.
B Click the appropriate button on the toolbar.

[=]
= | tEBRRBR P E®E| T

L— Goto End

W Press the Ctrl+ End keys on the keyboard.
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3.3.3 Editing Voice Data

Since all the voice data files are read into the PC memory on the WaveEditor window, a simultaneous editing of a great
number of waveform data items may have harmful effects such as dramatic deterioration of the processing speed of PC.
Therefore, the following editing restrictions are imposed on the WaveEditor window:

o Editing of large files is restricted. The size of a file that can be edited is 10 minutes with the sound quality equivalent
to a CD although it varies depending on the sampling frequency of the voice data.

e The number of voice data files that can be edited concurrently is a maximum of 20.

e The number of UNDO operations that are allowed for each voice data file is a maximum of 5.

Although PC performance deterioration can be minimized by applying these restrictions, they may not function
sufficiently depending on the memory size installed or the applications being used concurrently. In that case, close large
files or restart the entire Tool.
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3.3.3.1 Specifying a Range

A waveform window allows the user to specify an arbitrary range for the given waveform and use the copy, cut, and
paste functions in the window.

File Edit WView Play Insert Effect Window Help

004_08_01.wav

00:00:00'DOC0 [m:m:lﬁ'ﬁm
| 00:00:01'936"000
00:00:01'936"000

To specify a range, move the cursor to the right while holding down the mouse button on the start point, then release the
mouse button on the end point.
To choose the entire waveform, use the following method:

W Select "Select All” in the “Edit” menu.
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3.3.3.2 Inserting a Silence Interval

Open the Insert Silence dialog box using the following method, then insert a silence interval into an arbitrary location in
the given waveform.

W Select “Silence...” in the “Insert” menu.

Insert Silence — I

e
= zample frames
Inzert

at; [ Cursor

[ (]9 ][ Cancel ]
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3.3.33 Fade-in / Fade-out
Use the following method to execute fade-in processing to the currently selected waveform segment:

W Select “Fade In” in the “Effect” menu.

File Edit View Play Insert Effect Window Help

0D 0D DD D00 DD [I]:[I]:l]-ﬁl]]

| | 00:00:01'936"000 | |
00:00: 01936000 00:00:03"936"000

Likewise, use the following method to execute fade-out processing to the currently selected waveform segment:

B Select “Fade Out” in the “Effect” menu.
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File Edit View Play Insert Effect Window Help

004_08_01.wav

00:00:00'DOC [m:m:lf_"fm
| 00:00:01'935"000
00:00:01'936"000

|

‘ I l"-,___]hl-«. |h'.Jr|'~

Sample rate{Hz): 4000

3.3.34 Effect (Normalize)

Open the Normalize dialog box using the following method and perform the normalization processing of the currently
selected waveform segment.

W Select “Normalize...” in the “Effect” menu.
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3.335  Effect (EQ)

Open the EQ dialog box using the following method and perform equalization processing of the currently selected
waveform segment.

W Select “EQ..." in the “Effect” menu.

Giain [dE]: -5 5 4

+[ +[

Freq [Hzl: 250 1000 4000 16000 V?étén]w

10 20 100

Ereview Bypass

Clicking the “Preview” button allows the results of effect processing to be previewed. At this time, if the "Bypass”

checkbox is selected, the Tool compares the equalization processing results with the waveform before the equalization
processing.
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3.3.3.6 Effect (Filter)

Open the Filter dialog box using the following method and perform the equalization filter processing of the currently
selected waveform segment.

W Select “Filter...” in the “Effect” menu.

Filter

Preview Bypas= Cancel
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3.3.3.7 Effect (Quality)

Open the Quality dialog box using the following method and perform the equalization filter processing of the currently
selected waveform segment.

B Select “Quality...” in the “Effect” menu.

—
+[ +0 i} +0
Cluality High Foundness  Wolume

Emphasiz [dE]
[4E]

Dngass [ 0k ][ Cancel ]
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3.34 Saving Voice Data

3.34.1 Overwrite-Saving

To overwrite pre-edit voice data with edited voice data and save it, use either of the following methods:
B Select “Save” in the “File” menu.
M Click the appropriate button on the toolbar.

3.3.4.2 Saving under an Alias

To save edited voice data under an alias, use the following method to open the “Save As” dialog box, then specify a new
name of the saving file:
W Select “Save As” in the “File” menu.

When saving voice data under an alias, a confirmation message is displayed asking whether the user wishes to replace
the pre-edit voice data that had been recorded in the main window with the voice data file that has been saved under an
alias.

Speech LS| Utility X

9P ) The wave file was saved as new wave file by wave editar,
M_-JJ @re wou sure ko wank ta replace the content of the ikems that have following addressy
Cihsamplel\E16_0b.waw

address 01

Y5 l [ Mo

Confirm the message content, then if you accept the replacement, click ”Yes”.
Note that if Overwrite Save is selected for the voice data already opened on the WaveEditor window, the data will
forcibly be overwritten and saved without displaying the confirmation message, even during edit.

3.35 Exiting the WaveEditor Window

To exit the WaveEditor window, do the following on the same WaveEditor window:

W Select “Exit” in the “File” menu.
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3.4 SDCB Controller

3.4.1 Support LSIs

The SDCB Controller supports the following speech synthesis LSIs:
ML22594
ML22530
ML22Q532
ML22Q533
ML22Q535
ML22620
ML22Q623
ML22Q624
ML22Q625
ML22Q626
ML22660
ML22Q663
ML22Q664
ML22Q665
ML22Q666

3.4.2 Starting SDCB Controller

Make sure that the sound device control board is properly connected to the PC via a USB cable, then use the following
method to start the SDCB Controller from the main window:

Refer to the “Sound Device Control Board3 User’s Manual” for the operating conditions and various settings for the
sound device control board.

W Select “SDCB Controller...” in the “Tools” menu.

B Untitled - Speech LSI Ukility
File Edit Tools Options View Help

0= WaveEditor..

Device: |V SDCB Controller.. 1

T r Settings... Internal RO
Bank 1
r Phrase Address File

The SDCB Controller then starts and the following “SDCB Controller” window is displayed. (The appearance varies
depending on the sound device control board connected.)
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-
M SDCE Controller
Option Help
Dlevice : Bank.: of
Cho Chi Chz Ch3
(@) Phrase Mumber (@) Phrase Mumber (@) Phrase Mumber (@) Phraze Mumber
oo o04 002 Q0C 00 O mE O ooy o004 002 QoC 00 o4 M2 O oo 004 002 Q0C o0 04 B 0w oo o04 002 QOC 0 O mE O
oMo o05 003 Q0D O oE M3 Ol oM 005 003 QoD O M M3 Ol oMo o0 003 QoD o M5 M3 Ol oMo o05 003 QoD o o M3 Ol
ooz 00 O0A OQDE M2 Ol A 01 ooz 0QOE  00A QOE 012 e A Ol ooz O0E  00A OQDE M2 OE A D ooz 00 O0A OQDE M2 Ol A Ol
oz 007 O0B OQOF M O OB O oz Qo7 QOB QOF 2 M7 B O oz 007 QOB OQOF M 07 OB O ooz 007 O0B OQOF M O OB O
<« [ b « [ b « [ b « [ b
() Continuation () Continuation () Continuation () Continuatian
Clear Clear Clear Clear
Chval ﬂ Q00 g8 Chvol U Q00 g8 Chval U Q00 gg  Chval U D000 dE
off o off o oft o off o
100 100 100 100
+0.00 +0.00 +0.00 +0.00
[ Device [ Device [ Device [ Device
Valume G i de  Sunchronous Play
. []cho
whriter
[ew
E] =
h
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3.4.3 Writing a ROM Image and Verifying ROM Contents

In ML22530/ML22Q53X/ML22620/ML22Q62X/ML22660/ML22Q66X, the writer settings are required prior to writing
a ROM image and verifying ROM contents.

Open the "Option" menu, and then click "Writer setting..." to open the Writer Setting dialog box.

Writer Setting Lﬁj

Flash ROM interface

-

@ Serial Flash ROM interface f Internal Flash ROM interface

CPU command interface [Clock synchronous serial interface]

Flash pratect
@ Mot lUsze FF h
Use Access code FF h

[ Ok ] | Canel

L

® “Flash ROM interface”: Specifies how to access the Flash ROM.
® “Flash protect”

»  Specify whether to protect the Flash and the access code when the protection is used.
»  Set the same setting as that specified when creating a written ROM image.
»  Specify "Not Use" when the ROM image is not written.

To write a ROM image file into the sound device control board or verify the consistency between the contents of the
ROM image file and the ROM contents in the sound device control board, first click the “...” button in the SDCB
Controller window to display the "Open” dialog box and then select the target ROM image.

ﬂ ﬂ [ | J [ ] Device

Yolume ' dBE

Writer

Wirite Werifu Elarnk Check,

To write the ROM image, click the “Write” button; to verify the ROM contents, click the “Verify” button. For write or
verify processing to be performed, specific settings for the switches and jumpers on the reference board may be required.
For details refer to the documentation of the reference board used.

When a ROM image file is written to a device, the consistency between the selected file and the connected device is not
checked. Therefore, before writing with the "Write” button, be sure to check the consistency.

Click the “Blank Check” button to see if the chip of the connected device is an empty chip. (Valid only in the following
devices: ML22(P)80X/ML22(P)82X/ML22(P)86X /ML22(Q)573/
ML22Q553/ML22Q374/ML22Q394/ML22(Q)34X/ML22(Q)33X/ML22(Q)321)
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3.4.4 Playback

By controlling the playback function, the output voice on the actual device can be checked. Some devices allow
simultaneous playback of multiple channels (up to 4 channels). The SDCB Controller window automatically identifies
currently connected devices and displays as many control screens as the number of channels required.

Playback can be carried out in the following two ways:

W Selective phrase playback

B Combined phrase playback (continuous playback of specified phrases in arbitrary order)

3.4.4.1 Selective Phrase Playback

Take the following procedure to give the sound device control board instructions to play arbitrary phrases selected from

the list:

® Using the “Bank” pull-down list in the SDCB Controller window, set the number of ROM banks currently written to
the device on the board and the bank No. of the bank you want to play.

@ Select the “Phrase Number” radio button.

® Specify the phrase numbers of the phrases you want to play back from the phrase list.

@ Click the (playback) button.

Chi
a Phraze Mumber
nd 0 o0z W Mo 1| Ic 20
L S VI N T | O
0z 0 0A DE 12 16 1A E 22 X
oy 0B OF 13 17 B OF 2305

4 1] I
[ an || Fese |
~ | Continuation
Clear
-3.74
1.00
+0.00

[] Device
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3.4.4.2 Combined Phrase Playback (Continuous Playback of Specified Phrases in Arbitrary Order)

To continuously play back arbitrary phrases with or without the length of silence interval specified, take the following

procedure:

@ Using the “Bank” pull-down list in the SDCB Controller window, set the number of ROM banks currently written to
the device on the board and the bank No. of the bank you want to play.

@ Select the “Continuation” radio button.

® Enter the phrase numbers of the phrases you want to play back into the phrase specification fields in hexadecimal. To
insert a silence interval, enter a “-* followed by the length of silence interval (milliseconds) in decimal.

@ Click the ‘ﬁ/ (playback) button.

@ Continuation

oA e -0 00F

Clear

-ET4
1.00

+0.00

‘m \Z/ Dievice
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3.4.4.3 Play Setting

Play setting is enabled for ML22530/ML22Q53X/ML22620/ML22Q62X/ML22660/ML22Q66X. Play setting sets the
AMODE and FADE commands (Refer to the device data sheet for commands).

Open the "Option" menu, and then click "Play Setting..." to open the Play setting dialog box.

E3
Mode AMP dass High-pass filter
Speaker AMP
©sp (®) Class AB
(O Line AMP(SPP) OFF v
Class D

() Line AMP(LOLT)
POP noise suppression Internal DAC signal input Analog input from AIM

(") Disable

0dB e OFF i
(®) Enable

Fade-out (Stop play) Fade-out (Volume change)
() Disable (") Disable

(®) Enable ®)Enable | 128/32758 ~

“Mode”: Set the output mode.

“AMP class” : Set the amplifier for speaker amplifier output.
“High-pass filter” : Set the high-pass filter.

“POP noise suppression” : Set the pop noise suppression.

“Internal DAC signal input” : Set the internal DAC signal input.
“Analog input from AIN” : Set the analog input from AIN.
“Fade-out (Stop play)” : Set the fade-out when inputting Stop play.
“Fade-out (Volume change)” : Set the fade-out when change volume .
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3.4.5 Commands Input

Speech synthesis LSlIs are controlled by the commands input.

B Open the [Option] menu, and then click [Command line...] to open the command line dialog box.

Command line Lﬁj

Command Enter

4 [

Eratch file E]

L

To excecute a command, enter the command in the “Command” eytry field, and then press the Enter key or click the
“Enter” button.

To perform batch processing, enter the batch file path in the “Batch file” entry field, and then click the “Load” button.
The batch file path can be also specified by using file selection dialog box that opens when you click “...” button.

During batch processing, the “Load” button changes to a “Stop” button. Click the “Stop” button to terminate batch
processing after the currently executing command is completed.

When command execution or batch processing is performed, the log is displayed in the text area in the center of the
window.

345.1 List of Commands

Command Format Description

Write W [size] [data...] Writes data to the speech synthesis LS| host CPU interface
Read R [size] Reads data from the speech synthesis LSI host CPU interface
Wait WAIT [time] Stop execution for a specified time

Reset RESET The speech synthesis LSI is reset by the reset terminal

Batch terminate | EXIT Terminate the batch file

Command are not case sensitive.
Blank lines and comment lines (lines that start with a space, tab, or "#") are ignored.
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3.4.5.2 Write Command
Writes data to the speech synthesis LSI host CPU interface.
Item Description
Format W [size] [data ...]
[size] Specify the size of the data to be written as an integer value from 1 to 9, in bytes.
[data ...] Specify [Size] bytes of data separated by a space. 1 byte of data is specified as a 2-digit hexadecimal
number.
Response Refer to “3.4.5.7 Response Messages”.
Example W 3C80100
> 0K
3453 Read Command
Reads data from the speech synthesis LSI host CPU interface.
Item Description
Format R [size]
[size] Specifies the size of data to be read in integer values from 1 to 9 in bytes.
Response Refer to “3.4.5.7 Response Messages”.
Example W 1B0
> 0K
R1
> OK CF
3454 Wait Command
Stop execution for a specified time.
Item Description
Format WAIT [time]
[time] Specifies the time to wait in decimal integer values from 0 to 10000 in milliseconds.
Response Refer to “3.4.5.7 Response Messages”.
Example WAIT 10
> 0K
Remarks If the command is executed successfully, the response message will be displayed after the specified
time.
3.455 Reset Command
The speech synthesis LSI is reset by the reset terminal.
Item Description
Format RESET
Response Refer to “3.4.5.7 Response Messages”.
Example RESET
> 0K
3456 Batch Terminate Command
Terminate the batch file.
Item Description
Format EXIT
Response Refer to “3.4.5.7 Response Messages”.
Example EXIT
> 0K
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3.45.7 Response Messages
Item Description
> 0K Successful completion.

> OK [read data...]

Successful completion. (Read command)

> Invalid command

The command does not exist.

> Invalid format

The command format is incorrect.

> Communication error

An error occurred during communication with the speech synthesis LSI.

3.4.5.8 Batch processing

Commands are executed continuously by reading a text file that contains one command per line.

Item Description Remarks

Character code ASCII code

Line feed code LF(0x0A), CR(0x0D)

Exit conditions Any of the following When the “Stop” button is clicked, the batch processing is

1. End of file reached
2.  Error occurred

execution
4. Click “Stop” button

3. Batch terminate command

terminated when the currently executing command is
completed.

Maximum number | 1000 lines

of rows
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3.4.6 Save / Load Setting
Save / load the settings of the SDCB controller window, writer setting dialog, SAI dialog, and play setting dialog.
(Save / load are not executed for items which the target device does not support)

3.4.6.1 Save Setting
Open the [Option] menu, and then click [Save setuup...].

3.4.6.2 Load Setting

Open the [Option] menu, and then click [Load setuup...].
If the model of the file to be read is different from the model of the target device, a warning dialog is shown. Pressing
OK continues processing (*). Pressing Cancel breakes processing. If the loading fails, the process is broke.

* The setting of the window and dialogs may differ from the settings file. Check that the settins after loading are correct,
and then confirm the operation.
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3.4.7

SAI

This function controls the SAI (Serial Audio Interface). SAI is available for ML22530/ML22Q53X.

Open the [Option] menu, and then click [Serial Audio Interface...] to open the SAI dialog box.
After setting (1) to (6) below, click the play button to start the operation.

©9) =]
Channel setting Input / Output (6) Transmissionreceive format
Leftch Right ch (2) sampling frequency | BkHz ~ LRCLK
OE=3= OE=3= (3) [Byte swap (®)"L" level ; Lch, Hlevel : Rch
Octo Octo Tnput Output (O H" level : Lch, L™ level : Rch
CH1 CH1
O O SAI_IN |FlashROM | SAI_OUT AMP
OeHz OcHz 1 dock delay
(4) ® - Ena Ena *
[@]5E OcHs3 0O = = - = (®)Enable
@] Ena Ena Ena * O Disable
Ena: Enable -t Disable -
* Follows the setting in "Play setting” L
Left justification
5) volume
Left ch Right ch Right justification
cro BCLE
¥ [ ¥ [
off 0 off 0 Oz
() 64fs
CH1
' a8 ' & Bit order
off a off 0 (®) MSE first
(CILSE first
CH2
Off 0 Off 0 (@) 16hit
=E () 8bit
¥ [5n]e ¥ [l
off 1] off o]
7 ©®
No. Description
Q) Set the SAI Lch and Rch channels.

If the same channel is selected for Lch and Rch, only Lch will operate.
There are some limitations to the maximum number of mixing and playable channels depending on the
sampling frequency. (Refer to the device data sheet for details).

(2) Specify the sampling frequency used for the SAI.

3) Specify the order of byte-swapping of the data to be transmitted and the data to be received.

(4) Specify the combination of SAI_IN pin input and SAI_OUT pin output.

(5) Specify the Lch / Rch volume during SAI operation.

(6) Specify the format of the data to be transmitted and the data to be received.

@) Click to start the operation of the SAI.
If the button is clicked during phrase playback in the SDCB Controller window or when no clock
(BCLK or LRCLK) has been input, the SAI will not operate and a warning dialog will be shown.

(8) Click to stop the operation of the SAI.
If the button is clicked during phrase playback in the SDCB Controller window, the SAI will not stop
and a warning dialog will be shown.

9 Close the window.

If the button is clicked during SAI operation, SAI will be stopped and the window will be closed.
If phrases are being played in the SDCB Controller window, a warning dialog will be shown without
stopping SAI or closing the window.
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3.4.8 Closing the SDCB Controller Window

Click the close button in the upper right corner of the SDCB Controller window to close the window.
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3.5  Exiting the Tool

To exit the Tool, do the following in the main window:
W Select “Exit” in the “File” menu.

If the project being edited has not been saved, the system displays a message prompting the user to save it. Confirm the
message content and follow the instructions to save it.
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4. References

This chapter describes the user interface of the Tool. For this purpose, the interface is explained into two categories:
windows and dialog boxes.

4.1 Windows

4.1.1 Main Window

The main window is displayed first when the Tool is started. Besides editing a project, this window allows the following
to be displayed: edit phrase setting window, WaveEditor window, SDCB Controller window, and various dialog boxes.
The main window can even display the Mask Option Setting dialog box and Event Setting dialog box depending on the
model number of the LSI.

#8 Untitled - Speech LS| Utility - O pd
File Edit Tools Options View Help
D | | | B
Device: |ML22530 ~ Bank Div.: |1 w EBlank Area: +16648223 | hytes | ROM Capadty: 16777216 | bytes
Fosc: 4.096 [ MHz ROM Select: Internal ROM Blank Area: 6503212 [ mgec (Fs / Format = 5400 / HQ-ADPCM(1/5) ]
Bank 1 Add new item to bottom
Il Phrase Address File Path Length[ms] Fs Format PreProcess HF Filter
[ - a 004_08_01.aif C:¥Users¥crimson¥Docum 8000 6400 HQ-ADPCM(1/5)
S 1 008_08_01.aif C:¥Users¥crimsor¥Docum 8000 2000 HQ-ADPCM(1/5)
T 2 011 _08_01.aif C:¥Users¥crimson¥Docum 8000 11025 HQ-ADPCM(1/5)
- 3 012_16_01.aif C:¥Users¥crimson¥Docum 8000 12000 HQ-ADPCM(1/5) - -
d > - EROMOD - - - - - -
P o ] (TR Insert Edit ROM... \
Volume: Fs: 11025
Insert Blank Select all 4
I i 175y
Speed: . Format: HQ-ADPCM(1/5)
12 1 2 Filter Select: Delete Arrange
Pitch: % PreProcess Convert Create...
-20 0 20
Ready NUM

41.1.1 Menus

e File

» New: Creates a new project. If there is any project being edited, this command saves it after confirmation and
closes it, then creates an empty project file.
Open... (CTRL+O): Opens a project. If there is any project being edited, this command saves it after
confirmation and closes it, then creates an empty project file.
Close: Closes a project and exits the Tool. If there is any project being edited, this command saves it after
confirmation and closes it.

Save (CTRL+S): Saves the project being edited.

Save As...: Saves the project being edited under an alias.

Import ROM Data...: Displays the ROM Data Import dialog box.

Import TOD Data...: Displays the TOD Data Import dialog box.

Export Material...: Writes the voice data selected from the list out as a voice data file in PCM format.

VVYVVVVVY 'V
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Import Speech Sound Data...: Displays the dialog to select a text file to be imported as a Speech Sound Data.

Create ROM...: Displays the Create ROM dialog box.

Exit: Exits the Tool. If there is any project being edited, this command closes it after confirmation of saving it and
then exits the Tool.

—

Undo (CTRL+Z): Cancels the preceding editing operation. Supports multiple undo operations. Returns the
operation to the editing state one state before the Undo operation each time Undo is executed.

Redo (CTRL+Y): Re-executes the editing operation that was just returned by Undo. Proceeds to the editing state
one state after the Redo operation each time Redo is executed.

Phrase Copy (CRTL+C): Reads the selected phrases (only for the items whose checkboxes in the list are being
selected) into the clipboard.

Paste (CTRL+V): Pastes the item in the clipboard onto the current editing position. (The pasted item functions as
a duplicate of the copy source item.)

Delete (DEL): Deletes the currently selected item.

Replace (CTRL+R): Replaces the currently selected item with arbitrary voice data. Use the “Open” dialog box
that appears to select voice data.

Copy: Copies the currently selected item onto the selected bank. (If any edit phrase is copied, the voice data being
referenced by the edit phrase is also copied at the same time).

< Bank 1

< Bank 2

< Bank 3

< Bank 4

<o

-Select All (CTRL+A): Selects all the items in the list.
Hsert (CTRL+N): Creates a new edit phrase.

Insert Blank (CTRL+B): Creates an empty phrase.

I-E-(_jit ROM: Displays the edit phrase setting window in order to edit the edit phrase being selected in the list.
I\S/Vave Editor...: Displays the WaveEditor window.

SDCB Controller...: Displays the SDCB Controller window.

Settings...: Displays the WAV File Path Setting dialog.

tions

ML22(Q)53x/62x/66x...: Displays the User setting parameter Dialog Box (ML22(Q)53x/62x/66x).
ML28(Q)86x/87x...: Displays the User setting parameter Dialog Box (ML28(Q)86x/87x).

ML22(Q)321

<> Mask Option Setting...: Displays the Mask Option Setting Dialog Box (ML22(Q)321).

< Event Setting...: Displays the Event Setting Dialog Box (ML22(Q)321).

ML22(Q)57x/553...: Displays the HF Filter Active Frequency Dialog Box (ML22(Q)573/Q553/(Q)56x).
ML22(Q)56x...: Displays the HF Filter Active Frequency Dialog Box (ML22(Q)573/Q553/(Q)56X).
ML22Q374

<> Mask Option Setting...: Displays the Mask Option Setting Dialog Box (ML22Q374).

< Event Setting...: Displays the Event Setting Dialog Box (ML22Q374/ML22Q394).

ML22Q394

<~ Mask Option Setting...: Displays the Mask Option Setting Dialog Box (ML22Q394).

<~ Event Setting...: Displays the Event Setting Dialog Box (ML22Q374/ML22Q394).

ML22594

< Displays the HF Filter Active Frequency Dialog Box(ML22594).

ML610Q304...: Displays the Event Setting Dialog Box (ML610Q304/ML610Q359/ML610Q360/ML610Q380
Common).
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» ML610Q359...: Displays the Event Setting Dialog Box (ML610Q304/ML610Q359/ML610Q360/ML610Q380

Common).

» ML610Q360...: Displays the Event Setting Dialog Box (ML610Q304/ML610Q359/ML610Q360/ML610Q380
Common).

» ML610Q380...: Displays the Event Setting Dialog Box (ML610Q304/ML610Q359/ML610Q360/ML610Q380
Common).

View

» Toolbar: Toggles between showing and hiding the toolbar.

» States Bar: Toggles between showing and hiding the status bar.

Help

» About Speech LSI Utility...: Displays the version and copyright information of the Tool.

4.1.1.2 Control

“Device” pull-down list: Used to select the target LSI model number.

“Bank Div.” pull-down list: Used to set the number of bank divisions.

“Fosc”: Select source oscillation frequency.

“ROM Select” Enabled when the device has been selected that corresponds to the internal ROM and external ROM,
you can choose either.

“ROM Capacity [bytes]”: Displays the ROM capacity of the LSI being selected. ROM capacity needs to be specified
manually only in the case of a device that uses external ROM.

“Blank Area [bytes]”: With respect to the currently selected LSI or bank, this field displays the remaining capacity
(bytes) against the content currently being edited.

“Blank Area [msec]”: With respect to the currently selected LSI or bank, this field displays the remaining capacity
(msec) against the content currently being edited. Conditions for displaying can be changed with Condition Setting
dialog box, and it will be opend with right button.

List: Material voice data and phrases are managed in this window.

Checkboxes: Specifies whether to record the selected list item in the Phrase area.

“Phrase” column: Displays the management numbers in the Phrase area.

“Address” column: Displays the management numbers in the Address area.

“File” column: Displays the file names or phrase names of voice data.

“Path” column: Displays the paths for voice data. Double-Click to open the voice data location.

“Fs” column: Displays the sampling frequencies [Hz] during output of the ROM image of voice data.

“Format” column: Displays the formats used during output of the ROM image of voice data.

“PreProcess” column: Displays the state of preprocessing during output of the ROM image of voice data (When
the unsupported device has been selected, “-” is displayed on this column).

“HF Filter” column: Displays the type of HF Filter during output of the ROM image of voice data (When the
device excluding ML22(P)57X and ML22(P)56X has been selected , or when Fs is not equal to the frequency to
which HF Filter is applied, the blank is displayed on this column).

V VVVVVVVY

ubutton: Starts previewing the item being selected in the list. (Space)
C)

button: Stops previewing. (Space)
“Volume” slider: Sets the volume for preview.
“Speed” slider: Adjusts the previewing speed in the speech speed function (currently no device suppots this feature).
“Pitch” slider: Adjusts the previewing pitch in the speech speed function (currently no device suppots this feature).
“Convert”: Sets the sound quality to be used when voice data is written to a ROM image.
> “Fs”
< Checkbox : Select this checkbox if Fs is to be converted.
< Pull-down list: Used to select an Fs value.
“Format”
< checkbox : Select this checkbox if Format is to be converted.
< pull-down list: Used to select a Format value.
“Filter Select” (only supported in the ML22(P)57X)
< checkbox : Select this checkbox if Filter Type is to be converted.

\4

Y
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< pull-down list: Used to select a Filter Type value.
> “PreProcess”: Specifies whether to perform preprocessing for the speech speed function (currently no device

suppots this feature).
» “Convert” button: Reflects the sound quality settings to be used when the voice data being selected in the list is

written to a ROM image in accordance with the set content.
“Insert”: Creates a new edit phrase. (Ctrl+N)
“Insert Blank*: Creates a new empty phrase. (Ctrl+B)
“Delete”: Deletes the item being selected in the list. (Delete)
“Select All” button: Selects all the items in the list. (Ctrl+A)
“Edit ROM...” button: Displays the edit phrase setting window in order to edit the edit phrase being selected in the
list.
“Arrange” button: Optimizes the recorded content in the list and deletes the unused items automatically.
“Create...” button: Displays the Create ROM dialog box.

‘_/button: Moves the currently selected item in the list to the position one position higher than the current item.
(<)

‘_/button: Moves the currently selected item in the list to the position one position lower than the current item.
(=)
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4.1.2 Edit Phrase Setting Window

This is a window for editing edit phrases.

Phrase X
Wy
Name: ‘EROMO ‘
No | Address File

1 00 A.wav

2 = Mute 20 msec

3 01 B.wav

4 02 C.wav

\ / Select All Delete

File: 00 A.wav 2 Add
Mute Time: I:l msec | Replace Add
Volume: Set

o “Name*“: Sets the name of an edit phrase.

o List: Manages the items that compose an edit phrase.
»  “Address” column: Displays and select the management numbers in the Address area for voice data.
» “File* column: Displays the voice data file name or the lengths of silence intervals.

o “Select All” button: Selects all the items in the list. (Ctrl+A)

o “Delete”: Deletes the item being selected in the list. (Delete)

. button: Moves the currently selected item in the list to the position one position higher than the current
item. («)

. button: Moves the currently selected item in the list to the position one position lower than the current
item. (—)
o “File"
» Pull-down list: Selects voice data.
» “Add” button: Adds the voice data selected in the pull-down list to the edit phrase.
e “Mute Time“
» Enter the length of silence interval [ms] into this field.
» “Add” button: Adds a silence interval with the entered length of time to the edit phrase.
» “Replace” button: Change length of the selected silence interval with the entered length of time.
e “Volume *
» Enter the value of volume (00 ~ 1F) into this field.
» “Set” button: Change playback volume of the selected voice data with the entered value.
o “Close” button: Exits the window.
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41.2.1 The attention point of the silence insertion function of ML22Q374/ML22Q394, which a "Mute

Time" was used for.

Be careful with the silence insertion function of ML22Q374/ML22Q394 , which a "Mute Time" was used for.

~
When "Mute Time" is used at the end of phrase , the continuous playback of that phrase isn't done.
Modify it to the sound which "Mute Time" was used for and the silence voice data in the case of the continuous
playback mode.
Example 4) Phrase coposition in the case of countinuous playback using silence insertion function
The case of continuous playback using Scheduled play mode.
A X B X c X 1s silence m
1
| ¢— 1 edit rom phrase > < L
1 1
When "Mute Time"(1s silence) is used at the end of phrase, the continuous playback of that phrase isn't
done.
Change "Mute Time"(1s silence) to the combination of " "Mute Time"(980ms silence) and the silence
voice data*1 of 20ms".
“ i \[ the silence « - \[ the silence
AR S RO S
1
54— 1 edit rom phrase > ii < 1 edit rom phrase —Pi
J
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WaveEditor Window
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alized with 128Byte by choosing sampling frequency 6.4kHz, the 8bit PCM mode.

It iT stored on the installation disk.

Ready
4131 Menus
e File
» Close: This command closes voice data being edited and exits the Tool. If there is any voice data being edited, the

YV VY
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command saves it after confirmation and closes it.

Save (CTRL+S): Saves the voice data being edited.

Save As...: Saves the voice data being edited under an alias.

Exit: Exits the window. If there is any voice data being edited, this command closes it after confirmation of
saving it and then exits the window.

—

Undo (CTRL+Z): Cancels the preceding editing operation. Supports multiple undo operations. Returns the
operation to the editing state one state before the Undo operation each time Undo is executed.

Redo (CTRL+Y): Re-executes the editing operation that was just returned by Undo. Proceeds to the editing state
one state after the Redo operation each time Redo is executed.

Cut (CTRL+X): Cuts the specified segment of waveform data and reads it into the clipboard.

Copy (CTRL+C): Reads the specified segment of waveform data into the clipboard.

Paste (CTRL+V): Pastes the waveform data in the clipboard onto the current editing position.

Select All (CTRL+A): Selects all the sagmetns of waveform data.

Preference...: Displays the preference settings dialog box.

e View

>
>
>

Toolbar: Toggles between showing and hiding the toolbar.
States Bar: Toggles between showing and hiding the status bar.
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>
o Play

Properties...: Displays the properties of the voice data.

< Play / Stop (space): Starts or stops playback.

< Go to Start: Moves the playback cursor to the top of waveform.
<~ Go to End: Moves the playback cursor to the end of waveform.
S -

<~ Repeat: Turns on or off repeat playback.

e Insert

>

Silence...: Displays the Insert Silence dialog box.

o Effect

VVVYVY

\ A7

>

Fade In: Executes fade-in processing to the currently selected waveform segment.

Fade Out: Executes fade-out processing to the currently selected waveform segment.

Normalize...: Displays the Normalize dialog box and performs the normalization processing of the currently
selected waveform segment.

EQ...: Displays the EQ dialog box and performs the EQ processing of the currently selected waveform segment.
Filter...: Displays the Filter dialog box and performs the Filter processing of the currently selected waveform
segment.

Quality...: Displays the Quality dialog box and performs the Quality processing of the currently selected
waveform segment.

e Window

>
>
>

>

New Window: Creates a new display window.

Cascade: Rearranges multiple windows so that they will be stacked.

Tile: Rearranges multiple windows so that they will divide the screen into sections without overlapping one
another.

Arrange lcons: Arranges icons.

e Help

>

About WaveEditor...: Displays the version and copyright information of the Tool.
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4.1.4 SDCB Controller Window

4 ~
B S0CB Controller L i)
Option  Help
Bank.: of
Cho Chi Chz Ch3
@) Phrase Number @) Phrase Mumber @) Phraze Mumber @) Phrase Mumber
oo o04 002 00 M0 o4 B 0w oo 004 002 QOC M0 O 012 O oo 0o4 002 Q0C 00 04 M2 o oo o04 002 00 0 04 B 0w
oMo o05 003 QoD o s M3 Ol oMo o05 003 Q0D o s 013 Ol oMo Qo5 003 QoD o Ms M3 o oMo o05 003 QoD o M5 M3 Ol
ooz 00 00A OQDE M2 O A D1 ooz 00 O0A OQDE M2 O O1A O ooz 0QOE 00A QOE 012 e A o ooz 00 0Q0A OQDE M2 OE A D
ooz 007 QOB OQOF M oF OB O oz 007 O0B OQOF M O0F OB O oz 0oOF QOB OQOF 2 07 B 0 ooz 007 QOB OQOF M 07 OB O
4 2 4 2 4 » 4 S
Al Regat Al Fezat All Regat Al Regat
Continuation Continuation Continuation Continuation
Clear Clear Clear Clear
Chvol |_J W00 gg  Chval |‘J 000 dg Chiol |‘J 000 dB Chvol |‘J 000 4B
off o off o off o off o
100 100 100 100
+0.00 <000 +0.00 +0.00
j Device j Device j Device j Device
Valume |_J i de  Sunchronous Play
] Chi)
whriter
Chi
Chz
iite Werify Blank Check Ch

41.4.1 Menus

Options

» Command line...: Displays the Command line dialog box.

> Writer Setting...: Displays the Writer Setting dialog box.

Help

> About SDCB Editor...: Displays the version and copyright information of the Tool.

4.1.4.2 Control

“Device*: Displays the name of the LSI.
“Bank” pull-down list: Used to set the number of banks and the bank No. of the bank to be controlled.
“ChQ” / “Ch1” [ “Ch2” | “Ch3”: Performs control for each channel. (The number of channels that can be controlled
simultaneously varies for each device. In this window, as many control screens as the number of required channels are
displayed automatically in accordance with the connected device.)
» “Phrase Number”: Performs selective phrase playback.
< “Phrase Number” radio button: When selected, selective phrase playback is performed.
<> List: Displays the list of phrases. The phrase being displayed in reverse video after being clicked will be
played back.
< “All” button: Chooses all phrases.
< “Reset” button: Resets the phrase selected state.
» “Continuation”: Performs combined phrase playback.
< “Continuation” radio button: When selected, combined phrase playback is performed.
< Entry fields: Enter into these fields the numbers of the phrases you want to play back.
< “Clear” button: Clears the entered phrase numbers.
“CH VOL.” slider/entry field: Use these to set volume.
“Speed” slider/entry field: Use these to set playback speed.
“Pitch” slider/entry field: Use these to set playback pitch.

> \mbutton: Starts playback.

YV VYV
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» Pause button: Pauses playback.

> \L/button: Stops playback.

> Repeat button: Toggles between three repeat modes.
» “Device Repeat” checkbox: Switches between using and not using the repeat function of the device.
o “Volume” slider/entry field: Use these to set analog volume.
o “Writer”
> Entry field /”...” button: Use these to set path to ROM image file.
> “Write” button: Starts writing to ROM image.
>  “Verify” button: Starts verifying ROM image.
¢ “Blank Check” button: Check whether the chip on device is blank or not.
e “Synchronous Play”
» “Ch0” to “Ch3” check boxes: When using the channel synchronized playback function, if the checkbox of the
target channel is selected, channel synchronization will be performed as to playback processing and stop
processing on that checked channel. This function cannot be used if combined phrase playback is selected.
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4.2 Dialog Boxes

4.2.1 Create ROM Dialog Box

Create ROM K

TEST ROM Data
(®) Release ROM Data

() Motorola S File
(®) Binary File

Event area start address

Data area start address

2
2

Edit ROM area start address 2728 (HEX)

File:
C:¥Users¥Documents¥Untitled.bin

*Create ROM Dialog image when ML610Q360 selected

e “TEST ROM Data” radio button: OutputsML223xx ROM image for SDCB.
¢ “Release ROM Data” radio button: Release ROM data will be output in either of the following formats:
< “Motorola S File” (radio button)
< “Binary File” (radio button)
» “Event area start address” entry field: Specify in this field the event setting allocation address in hexadecimal
(only for supported devices).
1. “Data area start address” entry field: Specify in this field the voice data allocation address in hexadecimal (only
for supported devices).
» “Edit ROM area start address” entry field: Specify in this field the edit phrase allocation address in
hexadecimal.
o “File” entry field / “...” button: Use these to set path to the created ROM image file.
o “Apply” button: Automalically calculate and replace start addresses of “Data area start address” and “Edit ROM area
start address” from the address of “Data area start address” on generated ROM binary image.
o “OK” button: Outputs a ROM image and closes the dialog box.
e “Cancel” button: Closes the dialog box.




LAPIS Semiconductor Co., Ltd.

4.2.2 Mask Option Setting Dialog Box (ML22(Q)321)

S

Mask Option Setting

Device 5P| Setting ‘Walume Contral
MLZ2CE21 DOiata transfer type Clack paolarity
: Sets Yolume by YREF -pin
@il @ Marmal [H Lewvel]
~ | MSE first ~ 1 Rewverzal [L Lewvel]
Speaker Amp control
SPOFF Pin

Usze of Speaker Amp
~ 1 Pull Dovwen
Thermal check, Ol Full Up

Judgement Temperature 150C
[ [m]4 ] [ Close ]
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4.2.3 Mask Option Setting Dialog Box (ML22Q374)

Mask Option Settin

Device SFI Setting
RALZR(E])AT4 Use of speaker short detective Dlata transfer bype Clack polarity I
(@) LSE first (@) Mormal (H Lewvel]
() MEE First () Rewersal [L Lewel]
SEQ Pins Setting
SEG
[|uze of SEQI
Initial State

(@) L level Dutput
() Hlewel Qutput

Condition
i@ cMos

1 hleh Open Orain
i 1 Pch Open Drain
| | Hi-2

[ ok ][ Close |
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4.2.4

Dlewice

MLZZ[E) 3094

Use of speaker short detective

SEQ Pins Setting

SEGH

[|Vze af SEQ
Initial State
a L lewel Output
() Hlewel Qutput

Condition
@ CMOS
") Meh Open Drain
~ Pch Open Dirain
{ | Hi-2

Mask Option Setting Dialog Box (ML22Q394)

C5E Pins Setting

Initial State

| | L level Durput
(@) H level Qutput

Condition
(@) Peh Pull-up
i | Hi-2

Uze CSE

I2C Pins Setting

Slave address

Acknowledge setting

[ ok || Close

]
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4.2.5 Event Setting Dialog Box (ML22(Q)321)

Event Setting e
Riange | EVENT 02h~ 04h |
EVEMT!Pharaze 0th EVENT!Pharase 02h EYEMTIPharase 03h EVENT!IPharase 04h
EYENT Made | Flay once [F'Iag ance v] [F'Iagonce v] [F'Iag ance v]
Yaolume 1] Volume 3 Yaolume k] Volume 3
A WSl o W52 1) WE1 o WS n WSl o W52 o WSl o WS n
Transit Time
WS 1} WS4 1} W3 1} WS4 0 WS 1} WS4 1} W3 1} WS4 0

Apply ][ Cancel ][ Cloze

“Apply” button: Saves the currently displayed settings.
“Cancel” button: Returns the currently displayed settings back to their respective preceding settings.
“Close” button: Saves the currently displayed settings and exits the dialog box.

“Range* pull-down list: Select an event area where editing is performed. When this pull-down list is operated, each
setting that was being displayed before the operation is saved.
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4.2.6 Event Setting Dialog Box (ML610Q304/ML610Q359/ML610Q360/ML610Q380 Common)

Event Setting e
Riange | EVENT 00h~ 03h |
EYEMTIPharase 00h EYENT/Pharase Oth EYEMTIPharase 0zh EVENT!IPharase 03h
EYENT Made | Flay once Play onee Play once Play onee
Yaolume 10 Volume 10 Yaolume 10 Volume 10
A WSl o W52 1) WE1 1) WS n WSl o W52 1) WSl 1) WS n
Transit Time
WS 1} WS4 1} W3 1} WS4 L1} WS 1} WS4 1} W3 1} WS4 L1}

Apply ][ Cancel ][ Cloze

“Apply” button: Saves the currently displayed settings.

“Cancel” button: Returns the currently displayed settings back to their respective preceding settings.

“Close” button: Saves the currently displayed settings and exits the dialog box.

“Range* pull-down list: Select an event area where editing is performed. When this pull-down list is operated, each
setting that was being displayed before the operation is saved.

The number of displaying and editable event depends on current sound data number when selecting targetLSl is
ML610Q304/ML610Q359/ML610Q360/ML610Q380.
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4.2.7 Event Setting Dialog Box (ML22Q374/ML22Q394)

Event Setting e
Riange | EVENT 02h~ 04h |
EVEMT!Pharaze 0th EVENT!Pharase 02h EYEMTIPharase 03h EVENT!IPharase 04h
EYENT Made | Flay once [F'Iag ance v] [F'Iagonce v] [F'Iag ance v]
Yaolume 1] Volume 3 Yaolume k] Volume 3
A WSl o W52 1) WE1 o WS n WSl o W52 o WSl o WS n
Transit Time
WS 1} WS4 1} W3 1} WS4 0 WS 1} WS4 1} W3 1} WS4 0

Apply ][ Cancel ][ Cloze

“Apply” button: Saves the currently displayed settings.
“Cancel” button: Returns the currently displayed settings back to their respective preceding settings.
“Close” button: Saves the currently displayed settings and exits the dialog box.

“Range* pull-down list: Select an event area where editing is performed. When this pull-down list is operated, each
setting that was being displayed before the operation is saved.
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4.2.8 User setting parameter Dialog Box (ML22(Q)53x/62x/66X)

User setting parameter

Device

PALZ2530

Speech ROM
Information -

Lo ]

Mo, of Fhrase

() 1024
{2048
()02
LI

Source clock oscillation
(JRC
(@) H'tal

Flazsh protect

(@) Mot Use h

() Uze Lock protect h
D Use Acoess code I:I b
WOT

WOTERR ! RSTERF Processing

Transition to the state
after PUP command input

I:::I Hald current statuz

Overflow Time

()125ms
() 500ms
(@) 2=
(s

Error decision threshold

OC offzet h
Gain offset h

‘wlawe FOrm comparison h

Claz=z O AMF Setting

[ ]U=e Class D AMP

Cutput Farmat

Half-'w ave

Full-'w ave

Carrier Frequency

Mormal

AM-Avoidance

Clase

e “OK” button: Saves the currently displayed settings and close the dialog.
e “Close” button: Close the dialog without saving the currently displayed settings.
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4.2.9 User setting parameter Dialog Box (ML28(Q)86x/87x)

User setting parameter

Dewice

MLzFEED

Speczh RO
Infarmation

o

Mo. of Fhrare

(@) 1024
() z0dz
() 2072
() 409

Zourze clozk arcillation

(O FRe
(@) Heal

Flarhk prokezk

@ Mot Lz

O Ure Lozk prokezt

| FF |
R
L

(:::) Ure Azzerr code

wWoT
WOTERR fRETERFK Frozerring

Tranritiontokhereake
after FUF command input

O Hold zurrenkrtakur

OuerFlou Time

() 125mr
() 500ms
(@) &r
()

Error dezirion threrhold

DC affret

Qainoffrek

Wauve Farm zompariron

EIRE

Clarr D AMF Sokking

Ure Clars D AMF
Dukpuk Formatk

@ Half-Waue

O Full-Waue

CarrierFrequensy

@ Hormal

O AM-Avnidance

e “OK” button: Saves the currently displayed settings and close the dialog.

e “Close” button: Close the dialog without saving the currently displayed settings.
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4.2.10 HF Filter Active Frequency Dialog Box (ML22(Q)573/Q553/(Q)56x)

( HF Filter Active Frequency @
I | 16.0kHz -|
2 | 24.0kHz -|
3: | 25.6kHz -|
4 |32.0kHz -|
5:
&:
7.

e “Apply” button: Saves the currently displayed settings.

The frequency specified in each combo box is used as a frequency in which HF Filter can be applied.

4.2.11 HF Filter Active Frequency Dialog Box(ML22594)

[ HF Filter Active Frequency @ﬁ
[ 12.0kHz -| |Mae |
2 [ 1282 v| |Mae v
3: [ 16,064z v| |Mae v
4 | 24.0kHz v| |Male v
5: | 25.6kHz v| |Male v
6 |32.0kHz *| |Male |
7: | 48.0kHz v| [Male |

o “Apply” button: Saves the currently displayed settings.

Frequency are specified in each combo box will be the frequency that can be applied to HF Filter. In addition, the filter
type that is specified in the combo box that represents the filter type to the right of the combo box representing each
frequency, filter type will be available.( the filter types of “Filter Select” in “Convert”group on main screen were limited
to only available types set on this dialog)
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4.2.12 Wave Convert Dialog Box

Channel: [Leﬂ: channel anly

oK J [ Cancel

o “Channel” pull-down list: Use this to specify the mixing method in conversion from stereo to monaural.
o “OK?” button: Executes conversion of voice data and closes the dialog box.
e “Cancel” button: Closes the dialog box.

4.2.13 Save TOD Dialog Box

“Folder” display field: Displays the folder into which a TOD file is to be saved.

“...” button: Displays the dialog box on which the folder into which a TOD file is to be saved is selected.
“OK?” button: Performs speech synthesis, saves a TOD file, and closes the dialog box.

“Cancel” button: Closes the dialog box.
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4.2.14 TOD Data Import Dialog Box

Folder: G:itodh B

Total time of the chedked phrase[msec] :

™ | Phrase File Mame
|l ™Mynameis SpeechLsIUtiity  G:\tod\11020913333100.tod

|l whatis your name? G:\tod'\11020913333101. tod

Select All

“Folder” entry field: Enter the path to the folder that contains TOD file(s).

“...” button: Displays the dialog box on which the folder that contains TOD file(s) is selected.

“Open”: button: Opens a TOD file.

List: Displays a list of TOD files that have so far been opened. The items whose checkbox is checked are to be read.
“Select All” button: Selects all the items in the list.

“OK?” button: Reads TOD file(s) and then closes the dialog box.

“Cancel” button: Closes the dialog box.
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4.2.15 Condition Setting Dialog Box

' Condition Setting

Fs: [ﬁ4n|:|

Format: | 16bit PCM -

QK ][ Cancel ]

“Fs” pull-down list: Specify the sample frequency used in “Blank Area” field.
“Format” pull-down list: Specify the format used in “Blank Area” field.
“OK?” button: Save setting and closes the dialog box.

“Cancel” button: Closes the dialog box.

4.2.16 WAV File Path Setting Dialog

X

Settings

Way File Path

¥
[ C:¥Daocuments and Settings

% | ¥ | Delete

(0] 4 l [ Cancel

o “Wav File Path” list: When the voice file of the phrase is not found at the time of reading of a project file, the list of
directories with which the voice file of the same file name is searched is managed.

The folder selection dialog can be displayed and the target folder can be specified by clicking the button on the right of
each list item or by editing a list item directly.

. button: Move up to the selected item’s position. (the directory at the upper position of the list has high
priority when searching)

{ . ..
. button: Move down to the selected item’s position.

e “Delete” button: Delete selected item.
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4.2.17 Insert Silence Dialog Box

44100 2| sample frames

-

Insert

at: [ Cursor

[ Ok ][ Cancel ]

Each entry field: Set in this field the length of a silence interval to be inserted.

“at” pull-down list: Use this to specify the location at which a silence interval is inserted.
“OK?” button: Inserts a silence interval and closes the dialog box.

“Cancel” button: Closes the dialog box.

4.2.18 Normalize Dialog Box

Lewel [dE]

][ Cancel ]

o “Level [dB]” slider/ entry field: Use these to set the maximum level.
e “OK?” button: Performs normalization processing and closes the dialog box.
e “Cancel” button: Closes the dialog box.
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4.2.19 EQ dialog box

Gain [dE]: +3 -5 R +4 +0 +0

Freq [Hz]: 3] 250 1000 4000 15000 if'[:gtér?e

Ereview Bypass Cancel

“Gain [dB]” slider/ entry fields: Use these to set the gain level of each band.

“Freq [Hz]” entry fields: Display the frequency of each band.

“Volume [dB]”: Set an output level.

“Preview” button: Performs previewing.

“Bypass” checkbox: Switches between before and after processing as the object of previewing.
“OK?” button: Performs EQ processing and closes the dialog box.

“Cancel” button: Closes the dialog box.
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4.2.20 Filter Dialog Box

Filter

-
‘alume
[4E]

Freview Bypas= Cancel

“Type” pull-down list: Select a filter type.

“Gain [dB]” slider/ entry field: Set a gain level.

“Freq [Hz]” slider/ entry field: Set a frequency.

“Q” slider/ entry field: Set the Q value.

“Volume [dB]”: Set an output level.

“Preview” button: Performs previewing.

“Bypass” checkbox : Switches between before and after processing as the object of previewing.
“OK” button: Performs Filter processing and closes the dialog box.

“Cancel” button: Closes the dialog box.
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4.2.21  Quality Dialog Box

S{}und Quality

—
+0 +0 i} +00
Cluality High Foundness  Wolume

Emphasiz [dE]
[4E]

Dngass [ [u]: ][ Cancel ]

“Quality” slider/ entry field: Set a quality level.

“High Emphasis [dB]” slider/ entry field: Set a high-pass emphasis level.

“Roundness” slider/ entry field: Set a roundness level.

“Volume [dB]”: Set an output level.

“Preview” button: Performs previewing.

“Bypass” checkbox : Switches between before and after processing as the object of previewing.
“OK” button: Performs Quality processing and closes the dialog box.

“Cancel” button: Closes the dialog box.
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4.2.22 Command Line Dialog Box

il N
Command line ﬁ
Command Entar

4 2

Etatch file [ -]

A

“Command” entry field: Enter a command.

“Enter” button: Execute a command.

Text field: Displays the command execution log.

“Batch file” entry field: Enter a batch file path.

“...” Display file selection dialog box to specify batch file path.

“Load” button: Perform batch processing. During batch processing, the “L.oad” button changes to a “Stop” button.
“Stop” button: Terminate batch processing.
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4.2.23  Writer Setting Dialog Box

Writer Setting L-Ehj

Flazh ROM interface

[=] iSerial Flash ROM interface ! Internal Flash ROM interface

CPU command interface [Clock synchronous serial interface]

Flash protect
@) Mot Uze FF h

) Use Ascess code FF h

[ OK ] l Cancel ]

L

e “Flash ROM interface”: Specifies how to access the Flash ROM.

e “Flash protect”
> Specify whether to protect the Flash and the access code when the protection is used.
> Set the same setting as that specified when creating a written ROM image.
> Specify “Not Use” when the ROM image is not written.

o “OK?” button: Reflects the writer setting changes and closes the dialog box.

e “Cancel” button: Discards the writer setting changes and closes the dialog box.
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5.  List of Messages

This chapter gives a list of messages to be displayed by the Tool. Under each message are given the detailed message
content and countermeasures required.

5.1 Tool Body Related Messages

A required field was not entered.
No entry has been made to an item the entry of which is a must, such as a file name.

Can not change device because the active document includes compressed wave data which was imported from the
ROM image.

Since voice data that underwent the preprocessing for the speech speed function was imported from the ROM image,
changing to an unsupported device is impossible.

Can't display contents of the bank.
The content recorded in the bank cannot be displayed. A shortage of resources or internal program error may have
occurred.

Can’t find the corresponding device information.
No device information is found that corresponds to the target LSI name recorded in the project file. The configuration
file (Voicetool.ini) or the project file may be illegal or damaged.

Can't initialize wave output device.
Initialization of the audio output device failed. Using the control panel, check whether any appropriated audio device is
available in the current environment.

Can’t load device setting file.
An attempt was made to read the device setting file (Voicetool.ini), but failed. The file may not be correct or may be
damaged.

Can't load project file. Can't read or the file is not correct.
The project file could not be loaded. The file may not be correct or may be read-disable or may be damaged.

Can't load project file. Not supported project file format version.
The project file could not be loaded. The Tool does not support project files in this format.

Can't load material in project. (<filename>)

The material voice data file recorded in the project could not be loaded. The file must be stored in the same folder as the
one in which the project was saved. If the file has already been moved, bring it back to the original folder and then open
the project file again.

Can't save project file.
The project file could not be saved. Check whether the save destination is correct.

Can't set bit depth to wave output device
An attempt was made to configure the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.

Can't set block size to wave output device.
An attempt was made to configure the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.

Can't set number of channels to wave output device.
An attempt was made to configure the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.
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Can't set sample rate to wave output device.
An attempt was made to configure the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.

Can't start wave output device.
An attempt was made to start the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.

Can't stop wave output device.
An attempt was made to stop the audio output device, but failed. Using the control panel, check whether any
appropriated audio device is available in the current environment.

Device was changed.

The contents of project are changed.

Save a project?

An attempt has been made to change the target LSI. To save the project being edited before change, click Yes.

Failed to add new wave.
The voice data could not be recorded.

Failed to encode wave file.
The voice data could not be converted.

Failed to get module handle.
The handle of the program module cannot be obtained. An internal program error may have occurred.

Failed to make ROM image file.
An attempt was made to create a ROM image file, but failed.

There is a duplicated area between event setting area and sound data are. Please specify the address beginning
position in which duplication doesn't happen.

There is a duplicated area between event setting area and sound data area. Please correct it as described above message
<Only target LSI is changeable to event setting area and sound data area>

There is a duplicated area between event setting area and edit ROM area. Please specify the address beginning
position in which duplication doesn't happen.

There is a duplicated area between event setting area and edit ROM area. Please correct it as described above message
<Only target LSI is changeable to event setting area and edit ROM area>

There is a duplicated area between sound data area and edit ROM area. Please specify the address beginning
position in which duplication doesn't happen.

There is a duplicated area between sound data area and edit ROM area. Please correct it as described above message
<Only target LSI is changeable to sound data area and edit ROM area>

Invalid path was entered.
The specified file name or path is not correct.

Memory allocation error occurred. Quit application immediately.
A memory allocation error occurred. Probably caused by a shortage of resources.
Quit application immediately.

Maximum number of sub phrases is limited to N.
Maximum number of sub phrases in edit phrase is limited to N. Overflown phrases are ignored.
You have reached number limit of sub phrases (N) in edit phrase. Please adjust the number of sub phrases.
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Please select a Speech data for exporting.
Select the source voice data that is output as a material file.

PreProcess is disabled because Fs of the specified file is more than 32kHz.
When the sampling frequency of the voice data is set to 32kHz or larger, preprocess will be disabled automatically.

Selected Speech data is not converted into the ADPCM2.
The Tool only supports ADPCM2 as exportable format. Export Material cannot be executed, because the format of the
currently selected voice data is other than ADPCM.

Some bank(s) will be deleted. The contents which were added to them will be not saved. Are you sure to want to
delete the bank?

An attempt has been made to execute processing that reduces the number of banks. No contents recorded in the
banks to be reduced will be saved. If you wish to execute the processing to delete the banks and their contents,
click Yes.

Sound data (<filename>) are used in some edit phrase(s).

Delete them and also remove from edit phrase(s)?

The voice data that is about to be deleted is used in some other edit phrase(s). If you wish to not only delete the voice
data but also delete it from the edit phrase(s) that reference it, click Yes.

Therere are some wave data which frequency is more than 32kHz and preprocessed. The preprocessing of those
data is changed into off state.

The specified project file includes the voice data which sampling frequency is 32kHz or larger and preprocessed.
Preprocessing will be disabled automatically.

The following files exceed the size that can be written.

------- Bank xx -------

<filename>  [xxxxxxxx]Byte

Because there exists a file that exceeds the voice data size limit for the target LSI, a ROM image cannot be created.

Following voice data exceed 64k bytes. The size of one voice data should be less than 64k bytes.
There are sound data over 64kByte after converting. <Only when 64Kbyte limit is enabled>

The preprocessing of the wave data which frequency is more than 32kHz is not admitted.
Preprocessing can not be used only if the sampling frequency of the voice data is 32kHz or larger. Choose lower
sampling frequency, or disable preprocessing.
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The size of used phrase(s) exceed registerable phrase size of ROM format.

Are you sure to use this phrase?

An attempt has been made to record phrases beyond the maximum number of phrases that can be recorded in the
target LSI. If you wish to go ahead with the use of those phrases, click Yes and cancel the use of other phrases
appropriately.

The source file can not be overwritten.
Please enter another file name.
No voice data converted from stereo to monaural can be overwritten. Specify another file name.

<filename>

The specified wave file should be converted to monaural, because it has stereo channels.

Would you like to continue this procedure?

Any voice data file in stereo format will first be converted to a different file in monaural format, and then recorded in the
Tool. If you wish to perform this processing, click Yes.

The wave file was saved as new wave file by wave editor.

Are you sure to want to replace the content of the items that have following address?
<filename>

------- Bank xx -------

Address xx

Voice data was saved under an alias on the WaveEditor window. Select whether to replace the pre-edit voice data that
has been recorded with the voice data file that has been newly saved under an alias.

If Yes is selected, the voice data that has been listed is replaced with the file that has been newly saved.

If No is selected, the voice data that has been recorded is not replaced and the new voice data file is edited as a different
file on the WaveEditor window, irrelevant to the recorded original data.

Wave output device have been stopped by error.
The audio output device has been stopped by an error. Using the control panel, check whether any appropriated audio
device is available in the current environment.

5.2  Voice Data Editing Related Messages

Fatal error occurred while startup.
A fatal error occurred during application startup. Restarting the system is recommended.

Memory allocation error occurred.
A memory allocation error occurred. Probably caused by resource shortage.

Failed in the Undo execution.
An attempt was made to execute Undo, but failed. Probably caused by resource shortage.

Failed in the Redo execution.
An attempt was made to execute Redo, but failed. Probably caused by resource shortage.

Failed in transferring clipboard.
An attempt was made to transfer data to the clipboard, but failed.

The sampling rate of the wave data on the clipboard is different. The data is pasted without sampling rate
conversion.

The Wave data on the clipboard is different from that on the paste destination in the sampling rate. The data will be
pasted without sampling rate conversion.

The size that was able to be edited upper bound was exceeded.
The attempted operation cannot be executed, because the upper limit on the size that can be edited is exceeded.
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Sound data has to be * msec or more.
One or more sound data less than the specified playback time.

There are one or more sound data which is less than minimum time.
When changing the device, it will be displayed if it contains one or more sound data less than the specified playback
time of the changed device.

Can't open the file.
The file cannot be opened.

The file reading error occurred.
A file read error occurred.

The file writing error occurred.
A file write error occurred.

This file format is not supported.
This file format is not supported.

Can't edit more than %od files.
More than <the-number-of-files> files cannot be edited.

Cache initialization failed.
A shortage of system resources occurred. Cache initialization failed.

Thread initialization failed.
A shortage of system resources occurred. Thread initialization failed.

Wave output device initialization failed.
An attempt was made to initialize the sound playback device, but failed.

Wave output device is not found.
The sound playback device is not found.

Can't open wave output device.
The sound playback device cannot be opened.

Can't start wave output device.
The sound playback device cannot be started.

Can't stop wave output device.
The sound playback device cannot be stopped.

Wave output device have been stopped by error.
The sound playback device has been stopped due to an error.

The bit depth of the specified file is not supported.
The bit depth of the specified file is not supported.

The number of chanels is not supported.
The number of channels of the specified file is not supported..

Can't set block size to wave output device.
The block size could not be set in the sound playback device.

Internal error occurred. Unknown file type.
An internal error occurred. An unknown file type was detected.
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5.3  Sound Device Control Board Control Related Messages

Can’t establish connection.
USB communication with the sound device control board could not be established.

Can’t find the corresponding device information.
The device information corresponding to the connected sound device control board is not found. The device setting file
may not be correct or may be damaged.

Can’t load device setting file.
An attempt was made to read the device setting file, but failed. The file may not be correct or may be damaged.

Can't open <filename>.
The ROM image file <filename> could not be opened. Check the file.

Cha3 can't be used if sampling frequency is set to 12.0/24.0/48.0/11.025/22.05/44.1 kHz
Ch3 can’t be used with the set sampling frequency. There are some limitations to the maximum number of mixing and
playable channels depending on the sampling frequency (Refer to the device data sheet for details).

Checksum error.
A checksum error occurred as to the ROM image file. Check the file.

Device board type is undefined.
Undefined device type.

Enter Serial Mode Error!
The sound device control board could not be set in serial mode. Check the sound device control board. Check the sound
device control board.

Erase Error!
An attempt was made to erase the device ROM contents, but failed. Check the sound device control board.

Failed to create flash access object.
An attempt was made to initialize USB control, but failed. An internal program error may have occurred.

Failed to communicate with device by USB. Please make sure of the USB connection between the computer and
the SDCB, and connection between the SDCB and the target LSI, and then click the OK button.

An attempt was made to establish USB communication with the sound device control board, but failed. Check the USB
connection between PC and SDCB and the connection between SDCB and target LSI. Then click the OK button to retry
to establish communication.

Failed to get module handle.
The handle of the program module could not be obtained. An internal program error may have occurred.

Failed to get target information
An attempt was made to obtain the target information on the sound device control board, but failed. Check the sound
device control board.

Failed to get play status.
An attempt was made to obtain the play status of the sound device control board, but failed.

Failed to play all sound.
Playback start for the sound device control board could not be set.

Failed to play sound.
Playback start for the sound device control board could not be set.
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Failed to play sound address.
An attempt was made to set the play address for the sound device control board, but failed.

Failed to repeat sound on.
The repeat playback function of the sound device control board could not be set.

Failed to repeat sound off.
The setting of the repeat playback function of the sound device control board could not be cleared.

Failed to set bank.
Playback bank could not be set for the sound device control board.

Failed to set volume.
Playback volume of the sound device control board could not be set.

Filename is not entered.
Specify a ROM image file.

<filename> has no end-record.
The ROM image file<filename> has no end-record. Check the file.

<filename> has no valid data-record.
The ROM image file<filename> has no valid data-record. Check the file.

Format of <filename> is illegal.
The format of the ROM image file<filename> is illegal. Check the file.

Flash access object isn’t created.
USB control has not been initialized. An internal program error may have occurred.

Invalid data. <filename> : <line number>
The format of the setting file is invalid. Check the file.

Invalid end-record appeared.
The ROM image file has an abnormal end-record. Check the file.

Memory capacity of the specified ROM image is too large.
The memory capacity of the specified ROM image is too large. Check the file.

Mismatch between target LSI and file(File is <filename>).
Read errors may result. Continue anyway.
The model name of the target device differs from the model name in the reading file. Read errors can occur.

SDCB3 device driver is not installed.
(It may be automaically installed when first connected.)
SDCB3 device driver is not installed. The driver may be automatically installed when connecting for the first time.

Some address of record in <filename> is overlap.
Data in the ROM image file<filename> is duplicated. Check the file.

USB connection is initialized.
It has been detected that the the sound device control board has been reset by hardware reset; therefore, USB
communication control is initialized.
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USB connection is initialized because an exchange of the board was detected.
It has been detected that connection has been switched to a different sound device control board. Therefore, USB
communication control will be initialized.

Unknown error occurred.
An undefined error has been detected. An internal program error may have occurred.

Verify Failed!
An attempt was made to verify the ROM image, but failed. Check the ROM image file or the sound device control
board.

Verify Passed!
Verification of the ROM image succeeded.

Write Completed!
Writing to the ROM image succeeded.

Write Failed!
An attempt was made to writing to the ROM image, but failed. Check the ROM image file or the sound device control
board.

Blank Check: blank
The chip on device is blank.

Blank Check: not blank
The chip on device is not blank.

Please input LRCLK/BCLK.
An attempt was made to start SAIl without input of LRCLK and BCLK. Please input LRCLK and BCLK.

Please stop playback on all channels
An attempt was made to use a function that cannot be used during playback. Stop playback on all channels.
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5.4  Speech Synthesis Related

Can't load the CSV file(<filename>).
An attempt was made to read the speech synthesis phrase file (CSV file), but failed. The file may be wrong or may be
damaged.

Can't load the list of languages and speakers(%s) or no language is available.
Can't load the text file(<filename>).
An attempt was made to read the speech synthesis phrase file (TEXT file), but failed. The file may be wrong or may be

damaged.

Can't rename the TOD file(<filename>).
An attempt was made to rename the TOD file, but failed. Check the file.

Can't save the TOD file(<filename>).
The TOD file could not be saved properly.

Failed to play phrase.
An attempt was made to play the speech synthesis data, but failed.

Failed to skip phrase.
An attempt was made to skip playback of the speech synthesis data, but failed.

Failed to stop phrase.
An attempt was made to stop playback of the speech synthesis data, but failed.

Unexpected program error has occurred.
An undefined error.
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5.5 Option Related Messages

EVENT <event>h / SEQ<seq> - Delay (<delay>) is too large.
The Delay value is too large. Check the set value.

EVENT <event>h / SEQ<seq> - Number of Times (<numberoftimes>) is too large.
The Number of Times value is too large. Check the set value.

EVENT <event>h / SEQ<seq> - Pattern No. (<pattern>) is too large.
The Pattern No. value is too large. Check the set value.

EVENT <event>h / SEQ<seq> - Pulse Wide (<pulsewide>) is too large.
The Pulse Wide value is too large. Check the set value.

EVENT <event>h — Two or more patterns from 01h to 10h are used. Delay time of them is set to the same value.
Since two or more out of the pattern Nos. 01h to 10h are used, the corresponding Delay value is adjusted to the same
value.

Invalid data. The file might be broken.
Abnormal data. The file may be damaged.

ADPCM Fs should be 10.5Hz or less..
If a pattern No. of 17 to 24 is used and the corresponding phrase is to be encoded by ADPCM, the sampling frequency
must be 10.5 [kHz]. Check it separately.

Setting contents were applied.
The settings currently being displayed have been saved. They are displayed when the event area is changed at the Range
pull-down list or the Close button is clicked on the Event Setting dialog box.
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